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0. Introduction to the course  

0ɀ1 Group introductions  

Tutors introduce themselves. 

Students introduce themselves. 

0ɀ2 What do you hope to learn?  

Group discussion, tutor writes responses on board. 

0.1 Paratext is a computer program. What are some advantages of using a computer for 

translation work? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

0.2 What are some disadvantages or problems of using a computer? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

Teacher explains which of these problems will be dealt with during the course (i.e. how Paratext 

helps to avoid them). 

0.3 What are some things that you know about the Paratext program? What is it for? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

0.4 How do you think Paratext can help your translation work? (For people already using 

Paratext, how is it helping you already?) 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

0.5 What are some things that you want to learn from this course? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  
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0ɀ3 Course outline, objectives, etc.  

0.6 The goal of this course is for you to learn how to use Paratext well. 

0.7 If you have neveǊ ǳǎŜŘ tŀǊŀǘŜȄǘ ōŜŦƻǊŜ ƻǊ ƘŀǾŜƴΩǘ ǳǎŜŘ ƛǘ ƳǳŎƘΣ ǿŜ ǿŀƴǘ ȅƻǳ ǘƻ 

become confident in using Paratext for ordinary translation work. 

0.8 If you are already an experienced Paratext user, we want you to learn some new 

functions and be able to use them well in your work. We also want you to be able to 

teach other people. 

0.9 So everybody comes into the course with different levels of knowledge and 

experience. In order to teach you best, we need to separate you into two separate 

classes (beginner and advanced). That will enable each group to learn at their own 

pace. The beginners can practise a lot, and they ǿƻƴΩǘ ōŜ ŎƻƴŦǳǎŜŘ ōȅ ƘŀǾƛƴƎ ǘƻ ƭƛǎǘŜƴ 

to difficult things. And the experienced users can move quickly to new topics. 

0.10 Everybody will be working through the same course material. But the advanced class 

will be able to complete more modules (course sections) than the beginner class. 

0.11 At the end of the course you can take this handbook with you. You will have it to 

refer to if you forget any of the skills. And if you want to learn more, you can work 

ǘƘǊƻǳƎƘ ǘƘŜ ƳƻŘǳƭŜǎ ǘƘŀǘ ȅƻǳ ƘŀǾŜƴΩǘ ŘƻƴŜ ȅŜǘΦ There is extra material in the 

Appendices too (the sections at the back of the handbook). 

0ɀ4 How much do you know about Paratext already?  

0.12 Your tutor may have already asked you to fill in ŀ ǉǳŜǎǘƛƻƴƴŀƛǊŜ ŎŀƭƭŜŘ άIƻǿ ƳǳŎƘ Řƻ 

ȅƻǳ ƪƴƻǿ ŀōƻǳǘ tŀǊŀǘŜȄǘ ŀƭǊŜŀŘȅΚέ Lǘ Ŏƻƴǘŀƛƴǎ ǎƻƳŜ ǉǳŜǎǘƛƻƴǎ ŀōƻǳǘ Ƙƻǿ ƳǳŎƘ ȅƻǳ 

ǳǎŜ ŎƻƳǇǳǘŜǊǎ ŀƴŘ Ƙƻǿ ƳǳŎƘ ȅƻǳ ƘŀǾŜ ǳǎŜŘ tŀǊŀǘŜȄǘ ōŜŦƻǊŜΦ LŦ ȅƻǳ ƘŀǾŜƴΩǘ 

ŎƻƳǇƭŜǘŜŘ ǘƘƛǎ ǉǳŜǎǘƛƻƴƴŀƛǊŜ ȅŜǘΣ ȅƻǳΩƭƭ ōŜ ŘƻƛƴƎ ƛǘ ƴƻǿΦ 

0.13 This questionnaire will help the tutors to divide you into classes 

(beginner/advanced). It will also help the tutors to know which topics to concentrate 

on and teach more thoroughly. 

0.14 LŦ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ ŀ ŎƻǇȅ ƻŦ ǘƘŜ ǉǳŜǎǘƛƻƴƴŀƛǊŜ ƻƴ ŀ ǎŜǇŀǊŀǘŜ ǎƘŜŜǘ ƻŦ ǇŀǇŜǊ, you can 

find it in the appendix of this handbook called Pre-course skills assessment. 

Tutor looks through student checklists and streams students into beginner or advanced class. 

0ɀ5 More about the course  

Tutor talks through the following. 

0.15 This course has several components: 
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¶ learning modules ς at these times you will learn and practise new skills; 

¶ simulations ς these are practice exercises that are like doing real translation 

work, but ƛǘ ƛǎƴΩǘ ȅƻǳǊ ƻǿƴ ǘǊŀƴǎƭŀǘƛƻƴ ǇǊƻƧŜŎǘ ǎƻ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ ǘƻ ōŜ ŀŦǊŀƛŘ 

about making mistakes; 

¶ real work sessions ς at these times you can practise your new skills on your 

actual translation project. 

0.16 Asking for helpΥ ƛŦ ȅƻǳ ŘƻƴΩǘ ǳƴŘŜǊǎǘŀƴŘ ǎƻƳŜǘƘƛƴƎΣ ǇƭŜŀǎŜ ŀǎƪ ȅƻǳǊ ǘǳǘƻǊ ŦƻǊ ƘŜƭǇΦ It 

is better to ask and learn than to stay quiet and not understand. 

0ɀ6 Using the course handbook  

Class activity. 

0.17 There is a lot of information about Paratext in this handbook ς things that will be 

useful for you after the course when you are working with Paratext. For example, it 

contains many sets of instructions for how to perform different procedures. 

0.18 There are some parts of the handbook that you need to learn about now. Open your 

book to each of the parts so you know where they are. 

0.19 At the front there is a Table of Contents. If you know which module you want to look 

at, you can use the Table of Contents to quickly find the right page number. 

Learners complete the exercise. Tutor writes correct page numbers on board. 

0.20 At the back of the handbook there are several Appendices (sections with extra 

information). Look at each appendix and write the page numbers into the table: 

More procedures Hƻǿ ǘƻ Řƻ ǎƻƳŜ ǘƘƛƴƎǎ ǘƘŀǘ ȅƻǳ ǿƻƴΩǘ 

have time to learn in the course. 

 

Common USFM MARKERS A list of the markers that FORMAT your 

translation text. 

 

Keyboard SHORTCUTS for common tasks What keys to press to make things 

happen in Paratext. 

 

Glossary A dictionary of new terms found in 

this handbook. 

 

Skills checklist/list of procedures ! ŎƘŜŎƪƭƛǎǘ ǘƻ ǎƘƻǿ ȅƻǳ ǿƘŀǘ ȅƻǳΩǾŜ 

learnt and what you still need to 

learn. It has page numbers to help you 

find procedure instructions too. 
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0.21 Each paragraph of the book has a number (like this one does). The first part of the 

number is the module number. All paragraphs in a module start with the same 

number. The second part of the number is for that particular paragraph. 

Learners complete the exercise. There are many possible right answers. 

0.22 Different styles of writing in this handbook mean different things. Look through the 

handbook. For each style of writing, find a paragraph that displays that style. Write 

down the paragraph number in the table. 

TEXT LIKE THIS LŦ ȅƻǳ ŘƻƴΩǘ ƪƴƻǿ ǿƘŀǘ ǘƘƛǎ ǘŜǊƳ ƳŜŀƴǎΣ ȅƻǳ Ŏŀƴ ƭƻƻƪ ƛǘ ǳǇ ƛƴ 

the Glossary. 

 

Text like this This is the name of a section in the handbook. This writing 

tells you that you can find more information by looking at 

that section. 

 

Text like this This is the name of a keyboard key that you need to press.  

Ctrl + Z This means to hold down the Ctrl key and the Z key at the 

same time. 

 

Text like this This is the name of a MENU or FUNCTION in Paratext.  

Text like this This indicates something that you can see in a Paratext 

window. 
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1. Basics 

Module outline  

In this module, you will learn how to: 

¶ open and close the Paratext application; 

¶ open and close your translation project; 

¶ type text into your project; 

¶ save your project; 

¶ use Send/Receive to backup your project to a flash drive. 

 

1ɀ1 Opening and closing the Paratext application  

Tutor demonstrates, learners watch. 

1.1 We start by opening the Paratext application.  

Opening the Paratext application  

1. Find the Paratext 7 ICON on the desktop. It looks like this:  

2. DOUBLE-CLICK on the icon. The application will open. 

3. When the program has finished opening and is ready for work, you will 

see something like this: 
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1.2 bƻǿ ǿŜΩƭƭ close the application. 

Closing the Paratext application  

1. In the upper right corner of the Paratext window, find the square with a 

crosÓ ÉÎ ÉÔ ɉÉÔȭÓ ÃÁÌÌÅÄ Á Close BUTTON).  

2. Click this square. The program will close. 

Tutor demonstrates, learners perform each step of demonstration after the tutor. 

Learners practise independently. Repeat if necessary. Be sure that you can do this without looking at 

the instructions. 

1ɀ2 Features of the Paratext window  

Class activity. 

1.3 hǇŜƴ tŀǊŀǘŜȄǘ ŀƎŀƛƴΦ ²ŜΩǊŜ ƎƻƛƴƎ ǘƻ ƭƻƻƪ ŀǘ ǎƻƳŜ ƛƳǇƻǊǘŀƴǘ ŦŜŀǘǳǊŜǎ ƻŦ ǘƘŜ tŀǊŀǘŜȄǘ 

window. 

 

1.4 At the very top of the window is the TITLE BAR that says Paratext 7. At the far right of 

the title bar are three BUTTONSΦ ¸ƻǳΩǾŜ ŀƭǊŜŀŘȅ ǳǎŜŘ ǘƘŜ Close button. ²ŜΩƭƭ ƛƎƴƻǊŜ 

the other two. 

 

1.5 Down from the title bar is the MENU BAR. Here we will find all the Paratext FUNCTIONS 

ǘƘŀǘ ǿŜΩƭƭ ōŜ ǳǎƛƴƎΦ 

 

1.6 At the far right of the menu bar is the Help button. If you 

ǿŀƴǘ ǘƻ ƭŜŀǊƴ ŀōƻǳǘ tŀǊŀǘŜȄǘΩǎ Help FUNCTION, go to 

module  17 (5ÓÉÎÇ 0ÁÒÁÔÅØÔȭÓ (ÅÌÐ ÆÕÎÃÔÉÏÎ) on page 148. 

1.7 Down from the menu bar is the BUTTON BAR. Clicking on BUTTONs will do useful things. 

ό5ƻƴΩǘ ŎƭƛŎƪ ŀƴȅǘƘƛƴƎ ȅŜǘΗ) 
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1ɀ3 Opening and closing a project  

Class discussion. 

1.8 When you open Paratext 7 for the first time, you will not see any windows or 

text. Now you will learn how to open resources and projects. 

1.9 A PROJECT is a collection of files containing a Bible translation in progress ς ƛǘ ƘŀǎƴΩǘ 

been completed yet and it can be EDITed (changed). 

1.10 A RESOURCE is a collection of files that contains a published Bible text or the UBS 

Translation Handbooks (or something similar). ̧ ƻǳ ŎŀƴΩǘ ŜŘƛǘ a resource. 

1.11 What will we use a project for? What will we use a resource for? 

 .............................................................................................................................................................  

 .............................................................................................................................................................  

1.12 ²ŜΩƭƭ ƭƻƻƪ ŀǘ ǊŜǎƻǳǊŎŜǎ ƛƴ ŀ ƭƛǘǘƭŜ ǿƘƛƭŜΦ wƛƎƘǘ ƴƻǿ ǿŜΩƭƭ ƭƻƻƪ ŀǘ ǇǊƻƧŜŎǘǎΦ 

1.13 ²ŜΩƭƭ ǎǘart by opening a sample project called Mini Project. 

Tutor demonstrates, learners watch.  

Opening a project  

1. If the Paratext application is closed, open it. 

2. Go to the File  MENU. 

 

3. Choose Open Project/Resource...  
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4. This WINDOW has the heading Open Text. 

 

5. Look at the column on the right, with the heading Type. Each item on the 

list is either a RESOURCE or a PROJECT. 

6. The texts that you see in this list each have a unique name. You can find it 

in the column named Full Name. Each text also has a unique short name 

in the first column (Name). 

7. SCROLL down until you see the project you want to open. DOUBLE-CLICK on 

this item in the list to open it. 

 

Tutor demonstrates, learners perform each step of demonstration after the tutor. 

1.14 The screen should look something like this:  
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1.15 Now ǿŜΩƭƭ close the project. Notice that the project WINDOW has its own square with a 

cross in it (Close BUTTON). This is not the same Close button that closes the whole 

Paratext application! It just closes the project.  

Tutor demonstrates, learners watch.  

Closing a project  

1. Click on the Close BUTTON at the top right of the PROJECT WINDOW (not the 

application window!). 

 

Tutor demonstrates, learners perform each step of demonstration after the tutor. 

Learners practise independently. Repeat if necessary. Be sure that you can do this without looking at 

the instructions. 
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1ɀ4 Typing text  

Class activity.  

1.16 Open the Mini Project again.  

1.17 bƻǿ ǿŜΩƭƭ ŜƴǘŜǊ ǎƻƳŜ ǎŀƳǇƭŜ ǘŜȄǘΦ 

1.18 The CURSOR should be flashing next 

to the text \v 1. If it iǎƴΩǘΣ ŎƭƛŎƪ ǘƻ 

the right of \v 1 to move the cursor 

there.  

1.19 Type in the following text at that 

point: 

This is the list of ancestors of Jesus Christ, the son of David, the son of Abraham. 

1.20 Now SELECT the words the son of David. 

You select text by holding down the left 

mouse button and at the same time 

DRAGGING the mouse across the text. Then 

the text will become HIGHLIGHTED like this:  

1.21 DELETE (remove) these words by pressing 

the Backspace or Delete key. 

1.22 Now bring them back again by pressing Ctrl + Z. This is the Undo FUNCTION and it is 

very useful for undoing minor mistakes. 

1.23 Now select the words the son of Abraham. 

1.24 While the text is still selected and highlighted, type !ōǊŀƘŀƳΩǎ ǎƻƴ. You have very 

ǉǳƛŎƪƭȅ ŎƘŀƴƎŜŘ ǘƘŜ ǿƻǊŘƛƴƎ ƻŦ ǘƘŜ ǘŜȄǘΦ ¸ƻǳ ŘƛŘƴΩǘ ƴŜŜŘ ǘƻ ōŀckspace at all to get rid 

of the original words. 

1.25 Now SELECT the words Jesus Christ. 

1.26 Copy these words by pressing Ctrl + C. 

1.27 Move the cursor next to \v 10. 

1.28 Now Paste the words Jesus Christ by pressing Ctrl + V. Copy and Paste are quick ways 

to move text around or put the same text in several places. 

1.29 Now insert the cursor next to any verse marker and type anything you like. This is just 

ŀ ǇǊŀŎǘƛŎŜ ǇǊƻƧŜŎǘ ǎƻ ƛǘ ŘƻŜǎƴΩǘ ƳŀǘǘŜǊ ǿƘŀǘ ȅƻǳ ǘȅǇŜΦ Just become comfortable in 

entering text. Try not to press the Enter key at this point. But if you do, you can get 

rid of the box by pressing Esc (the key at the top left of the keyboard). 

1.30 LŦ ǘƘŜ ǾŜǊǎŜ ƳŀǊƪŜǊ ƧǳƳǇǎ ǘƻ ǘƘŜ ŜƴŘ ƻŦ ǘƘŜ ǇǊŜǾƛƻǳǎ ƭƛƴŜΣ ǘƘŀǘΩǎ ƻƪŀȅΦ 
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1.31 Also practise selecting text, copying, pasting and deleting. And practise using Undo 

(Ctrl + Z) to undo things. 

Copy SELECTed text. Ctrl + C 

Paste copied text. Ctrl + V 

DELETE selected text. Backspace or Delete 

Change selected text. 
Type new wording while text is 

HIGHLIGHTED. 

Undo a mistake. Ctrl + Z 

1ɀ5 Saving 

Class activity. 

1.32 Even though this is just a practice project, ȅƻǳΩƭƭ still practise saving your work. 

1.33 ²Ƙȅ Řƻ ǿŜ ƴŜŜŘ ǘƻ ΨǎŀǾŜΩ ŀ ŎƻƳǇǳǘŜǊ ŦƛƭŜΚ 

 ..........................................................................................................................................................................  

Saving a project  

1. Press Ctrl  + S. 

1.34 LǘΩǎ ǘƘŀǘ ŜŀǎȅΗ {ŀǾŜ ȅƻǳǊ ǿƻǊƪ ŦǊŜǉǳŜƴǘƭȅ ǎƻ ȅƻǳ ŘƻƴΩǘ ƭƻǎŜ ŀƴȅ ǿƻǊƪ ƛŦ ǎƻƳŜǘƘƛƴƎ 

goes wrong. 

1ɀ6 Send/Receive procedure  

Class instructor may choose to delay teaching about Send/Receive until module  10, Using Paratext as 

a Team, page 83. 

Class discussion, tutor writes responses on board. 

1.35 Before you do this procedure, it must be set up properly on your computer by a 

computer support person. That person can learn how to do it properly from the UBS 

document Paratext7.1ProjectSharingManual.pdf.  

1.36 Saving your file puts a copy onto your computer. But if something happens to your 

computer, you might lose all your work. 
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1.37 What else do you need to do as well as saving your work on your own computer? 

 ..........................................................................................................................................................................  

1.38 You need a BACKUP copy somewhere else. The simplest way of backing up is onto a 

FLASH DRIVE. Where should you always keep your backup copy? 

 ..........................................................................................................................................................................  

1.39 You should have two flash drives: one that you keep with your computer and one 

that you keep in another house. If fire destroys the house or rascals steal your 

computer, you will still have a backup of your work. Never keep your flash drive in 

your computer bag. If somebody steals your bag, they will get your flash drive too! 

1.40 LǘΩǎ ǾŜǊȅ ƛƳǇƻǊǘŀƴǘ ǘƻ ǳǎŜ ŀ flash drive ǘƘŀǘ ŘƻŜǎƴΩǘ ƘŀǾŜ ŀƴȅ VIRUSes on it! How can 

you make sure of this? 

1.  .........................................................................................................................................................  

2.  .........................................................................................................................................................  

3.  .........................................................................................................................................................  

1.41 Paratext 7 has a special function called Send/Receive that makes it easy to save your 

project onto a flash drive or even send a copy to the Internet. At the moment we will 

just look at doing Send/Receive to a flash drive. 

1.42 Send/Receive is useful for backing up, but it is useful for another reason too. If your 

team uses more than one computer, Send/Receive makes it very easy to share your 

work around so that every computer has the most up-to-date version of your project. 

²ŜΩƭƭ ƭƻƻƪ ƳƻǊŜ ŀǘ ǘƘƛǎ ƛƴ module  10 Using Paratext as a team. 

Tutor demonstrates, learners watch.  

Send/Receive a project to a flash drive  

1. Insert a VIRUS-free FLASH DRIVE into a USB PORT on your computer. 

2. !Ô ÔÈÅ ÆÁÒ ÒÉÇÈÔ ÏÆ 0ÁÒÁÔÅØÔȭÓ BUTTON BAR is the Send/Receive  BUTTON. 

Click on it. 

3. Wait until the Send/Receive  is done. Watch the green bar that shows 

how much progress has been made. 
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4. The flash drive now contains the latest copy of the work you have done in 

the project. 

5. Safely EJECT the flash drive. 

6. Put the flash drive somewhere safe (keep it in a different building to the 

one you keep your computer in). 

Tutor demonstrates, learners perform each step of demonstration after the tutor. 

Learners practise independently. Repeat if necessary. Be sure that you can do this without looking at 

the instructions. 

1.43 When you have finished your Send/Receive backup, close your project window. You 

can leave the main Paratext window open. 
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Module summary  

This module has shown how you can: 

Task Summary of steps Page 

Open Paratext. ¶ DOUBLE-CLICK on the Paratext 7 ICON on the desktop. 11 

Close Paratext. 
¶ Click on the Close BUTTON at the top right of the 

application. 
12 

Open your translation 

project. 

1. From the File MENU, choose Open Project/Resource... 

2. SCROLL down until you find your project in the list. 

3. DOUBLE-CLICK on your project. 

13 

Close your translation 

project. 

¶ Click on the Close BUTTON at the top right of the PROJECT 

WINDOW (not the application window!). 
15 

Enter text and make 

little changes easily. 

¶ Copy SELECTed text. Ctrl + C 

¶ Paste copied text. Ctrl + V 

¶ DELETE selected text. Backspace or Delete 

¶ Change selected text. 
Type new wording while 

text is HIGHLIGHTED. 

¶ Undo a mistake. Ctrl + Z 
 

17 

Save your project. ¶ Press Ctrl + S. 17 

Use Send/Receive to 

backup your project 

to a flash drive. 

1. Insert a VIRUS-free FLASH DRIVE into a USB PORT on your 

computer. 

2. Click on the Send/Receive button, then wait until the 

Send/Receive is done. 

3. Safely EJECT the flash drive,and store it somewhere safe. 

18 
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2. Displaying resources  

Module outline  

In this module, you will learn how to: 

¶ open and close a resource; 

¶ locate and display a specific verse within a resource or project; 

¶ open a different resource in an existing resource window; 

¶ arrange multiple resource and project windows on the screen. 

 

2ɀ1 Opening and closing a resource 

Class activity. 

2.1 LŦ tŀǊŀǘŜȄǘ ƛǎƴΩǘ ƻpen, open it. 

2.2 bƻǿ ǿŜΩƭƭ ƻǇŜƴ ŀ RESOURCE. This is exactly the same as opening a PROJECT. Open the 

resource called New International Version US 1984Φ LŦ ȅƻǳΩǾŜ ŦƻǊƎƻǘǘŜƴ Ƙƻǿ ǘƻ ƻǇŜƴ 

a resource or project, look back at Opening a project on page 13. 

2.3 Do you remember the difference between a resource and a project? 

2.4 A resource is a text which has already been  ΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ. 

You can read it, but you cannot  ΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ  it. 

2.5 A project is a Bible translation    ΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ, so you can    

ΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ  it. 

2.6 You have just opened a resource containing the New International Version of the 

Bible. Look at the TITLE BAR of the window. It has an ABBREVIATED (shortened) form of 

the name of the resource. What is the abbreviated name?    

 

2.7 {ƛƴŎŜ ǘƘŜ ǘƛǘƭŜ ōŀǊ ƻŦ ŀ ǊŜǎƻǳǊŎŜ ǿƛƴŘƻǿ ƻƴƭȅ Ƙŀǎ ǘƘŜ ŀōōǊŜǾƛŀǘŜŘ ƴŀƳŜΣ ƛǘΩǎ ƎƻƻŘ ǘƻ 

learn the abbreviated names of the Bible versions that you will refer to most often. 

2.8 Now close the resource window (click on the Close BUTTON). 

2.9 Now open a different resource (you choose). What is its full name? What is its 

abbreviated name? 

Full name:  ......................................................................................................................................................  
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Abbreviated name:  ......................................................................................................................................  

2ɀ2 Displaying a specific verse in a resource  

2.10 Look at the TITLE BAR for the resource window that you just opened. What book, 

chapter and verse is it showing? 

 ..........................................................................................................................................................................  

2.11 Now look at the Paratext BUTTON BAR. In the middle you can see the name of the 

project/resource, the book name (e.g. Matthew, Mark), the chapter and verse 

reference. It looks like this: 

 

2.12 Paratext always uses standard English abbreviations for book names. For example, 

Paratext will always use PHP for Philippians, even if we are using a resource or 

project in another language that might use the letter F for the beginning of the name 

Philippians. 

2.13 Now we will learn how to display a different book/chapter/verse. ²ŜΩƭƭ Ǝƻ ǘƻ WƻƘƴ 

8:51. 

Tutor demonstrates, learners watch.  

Displaying a specific verse  

1. Press Ctrl  + B (remember B for Book). The box with the book name 

becomes HIGHLIGHTED. 

2. Type the first letter of the book you want (if it starts with a number like 

1 Corinthians, type 1). A list drops down showing all the books that start 

with that letter/number.  
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3. Keep typing letters until the list only shows the book you want. 

 

4. Press Spacebar. Now the chapter number box is highlighted. 

 

5. Type in the chapter number you need, and press Spacebar. Now the 

verse number box is highlighted. 

 

6. Type in a verse number and press Enter . Your resource now moves to 

that exact verse. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  

Learners practise independently. Be sure that you can do this without looking at the instructions. 

2.14 Practise going to the following verses: Philippians 2:5, 1 John 4:11; James 5:16. 
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2.15 Go to Luke 1:1. Now suppose you want to go to Luke 2:1 (the start of the next 

ŎƘŀǇǘŜǊύΦ ¸ƻǳ ŘƻƴΩǘ ƘŀǾŜ ǘƻ ǘȅǇŜ ƛƴ ǘƘŜ ŎƘŀǇǘŜǊ ƴǳƳōŜǊΦ There is a quick way. 

Tutor demonstrates then learners copy.   

Moving chapter -by-chapter through a resource or project  

1. Locate the box that lets you select the chapter number. 

2. Just to the right of this box is a pair of 

arrow BUTTONS. 

3. Click on the right-pointing arrow BUTTON to move forward to the 

beginning of the next chapter. (Click on the left-pointing arrow to move 

backwards.) 

2.16 Practise moving to the start of each chapter of Luke. 

2ɀ3 Open a different resource  in an existing resource window  

2.17 Suppose you want to quickly check the same verse in a different translation. You can 

switch to the other resource within the window that you have open now. 

Tutor demonstrates, learners watch.  

Open a different resource in a  resource window  that is already open  

1. If you have more than one window open, make sure a resource window is 

SELECTed. Do this by clicking anywhere in the window. The TITLE BAR of 

that window becomes a stronger colour. 
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2. Look ÁÔ ÔÈÅ 0ÁÒÁÔÅØÔ ×ÉÎÄÏ×ȭÓ BUTTON BAR. Find the box that shows the 

resource name. It looks like this: 

 

3. Click on the downward-pointing arrow. A list of all the resources and 

projects will drop down. 

 

4. Click on a different resource from the list. The resource window should 

still show the same book/chapter/verse reference as before, but now it is 

from the translation that you just selected. You can check this by looking 

at the winÄÏ×ȭÓ TITLE BAR to see whether the resource name has changed. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  

Learners practise independently. Be sure that you can do this without looking at the instructions. 

2.18 Practise opening different resources within the resource window. 

2.19 Click on the list of resources again, and look at all the different translations available 

to you to refer to. List three or four resources that you think will be very useful for 

your translation team to use. 

 ..........................................................................................................................................................................  
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 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

2.20 Now from the same list, SELECT English Practice Project. 

2.21 Practise locating different Bible references within the project. Since the project only 

Ŏƻƴǘŀƛƴǎ ǘƘŜ bŜǿ ¢ŜǎǘŀƳŜƴǘΣ ȅƻǳ ǿƻƴΩǘ ǎŜŜ ŀƴȅ h¢ ōƻƻƪ ƴŀƳŜǎ ƛƴ ǘƘŜ ƭƛǎǘΦ 

2.22 Go back to the File menu and open another resource. Yes, you can have multiple 

resources open at one time, as well as your project! Each resource or project has its 

own window. Note that the resource opens to the same chapter and verse as the 

other window. 

2.23 Open a third resource (in its own window). Is it at the same chapter and verse too? 

2.24 Change the book/chapter/verse. Notice how all the windows change to the new 

place. 

2ɀ4 Arranging windows (basic)  

2.25 Open two more resource windows. You should now have five windows open. The 

screen is getting a bit crowded and a bit messy! [ŜǘΩǎ ƭŜŀǊƴ ŀōƻǳǘ Ƙƻǿ ǘƻ ŀǊǊŀƴƎŜ 

these windows in a good way for working. 

Tutor demonstrates, learners watch. 

2.26 Go to the Window menu and choose Stacked 1 Column. Do you like this layout? 

 

Tutor demonstrates  2.27- 2.32, learners perform each step of demonstration after the tutor. Discuss 

the questions after performing each action. 
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2.27 Go to the Window menu and choose Stacked 2 

Column. Do you like this layout?    

2.28 Go to the Window menu and choose Stacked 3 

Column. Do you like this layout?    

2.29 When ȅƻǳ ŎƘƻƻǎŜ ŀ άǎǘŀŎƪedέ ƭŀȅƻǳǘ, Paratext 

automatically changes the size and position of the 

windows to fit them all on the screen (with no 

overlaps). This picture shows a layout using 

Stacked 3 Column. It may not look exactly the 

same as your screen (it depends on how many windows are open, and other things). 

 

2.30 Choose Stacked 2 Column again. 

2.31 Now close a resource window. What happens? 

 ..........................................................................................................................................................................  

2.32 Now open another resource window again. What happens? 

 ..........................................................................................................................................................................  

2.33 There is also a layout option called Unstacked. This lets you move windows around 

and arrange them how you like. 

Tutor demonstrates, learners copy. 
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2.34 Go to the Window menu and choose Unstacked. 

2.35 Now SELECT one window and move it to somewhere else on the screen. 

Tutor demonstrates, learners watch. 

Moving a window  

1. Click on the TITLE BAR of the window, ÂÕÔ ÄÏÎȭÔ ÒÅÌÅÁÓÅ ÔÈÅ ÍÏÕÓÅ ÂÕÔÔÏÎ. 

 

2. Now DRAG the window anywhere else on the screen. 

3. Release the mouse button and the window will stay in the new position. 

Tutor demonstrates, learners perform each step of demonstration after the tutor. 

Learners practise independently. Be sure that you can do this without looking at the instructions. 

2.36 LǘΩǎ ŀƭǎƻ ǇƻǎǎƛōƭŜ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ǎƛȊŜ ƻŦ ŀ ǿƛƴŘƻǿΦ  

Tutor demonstrates, learners watch.  
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#ÈÁÎÇÉÎÇ Á ×ÉÎÄÏ×ȭÓ ÓÉÚÅ 

1. Place the CURSOR at the edge of the 

window (any edge or corner). The cursor 

will change into two arrow heads. 

2. While the cursor is showing the arrow 

heads, click and hold the mouse button. 

3. While holding down the mouse button, 

DRAG the mouse and the window will 

change size. 

4. Release the mouse button and the window will be a new size. 

Tutor demonstrates, learners perform each step of demonstration after the tutor. 

Learners practise independently. Be sure that you can do this without looking at the instructions. 

Tutor should monitor what the learners are doing and help anyone who gets confused, especially if 

ǘƘŜȅ ŘƻƴΩǘ ǳƴŘŜǊǎǘŀƴŘ ǘƘŜ ŘƛŦŦŜǊŜƴǘ ōŜƘŀǾƛƻǳǊǎ ƻŦ άǎǘŀŎƪŜŘέ ŀƴŘ άǳƴǎǘŀŎƪŜŘέΦ 

2.37 tǊŀŎǘƛǎŜ ǎŜƭŜŎǘƛƴƎ ŘƛŦŦŜǊŜƴǘ ƭŀȅƻǳǘǎΣ άǎǘŀŎƪŜŘέ ƻǊ άǳƴǎǘŀŎƪŜŘέΦ aƻǾŜ ǿƛƴŘƻǿǎ 

around, change their size, open and close windows. Experiment with different 

layouts. Which one do you like the best? Which one would you find most 

comfortable for entering text into a project? 

 ..........................................................................................................................................................................  

Class activity. 

2.38 Close Paratext. (DƻƴΩǘ ŎƭƻǎŜ ŜŀŎƘ ǊŜǎƻǳǊŎŜ ǿƛƴŘƻǿ ŦƛǊǎǘΦ Wǳǎǘ ŎƭƻǎŜ ǘƘŜ ǿƘƻƭŜ 

application.) 

2.39 Open Paratext again. 

2.40  Are your resource and project windows all open again, and in the same locations as 

before? If they have moved at all, why do you think this happened? 

 ..........................................................................................................................................................................  

2.41  Are all the windows open to the same Bible reference as before?    

2.42 ¸ƻǳ Ŏŀƴ ƭŜŀǾŜ ȅƻǳǊ ǇǊƻƧŜŎǘ ǿƛƴŘƻǿ ƻǇŜƴ ǘƻƻΦ ¢Ƙƛǎ ƳŜŀƴǎ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ ǘƻ ƻǇŜƴ 

everything each time you start a work session. Paratext remembers what was open 

last time. 

2.43 Close all the open windows. 
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2.44 In module  13 (More on screen layout) we will learn some advanced options for 

displaying projects and resources. For example, if you want to open many resources 

or projects at the same time, you can use the function Open Project/Resource in 

Text CollectionΧ See the handbook section Text Collections on page 112. 
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Module summary  

This module has shown how you can: 

Task Summary of steps Page 

Open a Paratext 

resource. 

1. From the File MENU, choose Open Project/Resource... 

2. SCROLL down until you find the resource you want. 

3. DOUBLE-CLICK on the resource. 

13 

Close a resource. 
¶ Click on the Close BUTTON at the top right of the 

RESOURCE WINDOW (not the application window!). 
15 

Display a specific 

verse in a 

resource/project. 

1. Press Ctrl + B. 

2. Type the first letter or number of the book you want. A 

list drops down showing all the books that start with 

that letter/number. 

3. Keep typing letters until the list only shows the book 

you want. 

4. Press Spacebar to move to the chapter number box. 

5. Type the chapter number you need. 

6. Press Spacebar to move to the verse number box. 

7. Type the verse number you want. Then press Enter. 

22 

Move chapter-by-

chapter through a 

resource/project. 

¶ Click on the right-pointing arrow BUTTON that is next to 

the chapter selection box. 
24 

Open a different 

resource in an 

existing resource 

window. 

1. Click in a resource window to SELECT it. 

2. Locate the box with the list of resources (on the 

Paratext BUTTON BAR). 

3. Click on the downward-pointing arrow, and select the 

resource you want. 

24 

Arrange windows on 

the screen as 

άǎǘŀŎƪŜŘέ. 

¶ Go to the Window menu and choose Stacked 1 

Column, Stacked 2 Column or Stacked 3 Column. 
26 
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Task Summary of steps Page 

Arrange windows on 

the screen 

άǳƴǎǘŀŎƪŜŘέ. 

¶ Go to the Window menu and choose Unstacked. Now 

you can move windows to wherever you like. 
27 

Move a window. 

1. /ƭƛŎƪ ƻƴ ǘƘŜ ǿƛƴŘƻǿΩǎ TITLE BAR ōǳǘ ŘƻƴΩǘ ǊŜƭŜŀǎŜ ǘƘŜ 

mouse button. 

2. DRAG the window where you want it, then release the 

mouse button. 

28 

Resize a window. 

1. Place the CURSOR at the edge of the window. The cursor 

will change into two arrow heads. 

2. Click and hold the mouse button. 

3. Move the mouse until the window is the right size. 

Then release the mouse button. 

29 
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3. Practice session 1 (simulation)   

Module outline  

In this module you will perform a very simple SIMULATION of working on a Bible translation, 

using the skills you have learnt so far. 

 

3ɀ1 Introduction  

3.1 Follow the instructions below to create a mini-translation in Tok Pisin. This simulation 

will help you learn the basic steps of using Paratext in your translation work. It will 

also help you practise the skills you have learnt so far. 

3.2 The simulation instructions have two parts. The first part summarises the steps of the 

procedure for doing translation in Paratext. The second part gives specific 

instructions for this simulation (what project to use, what resources to have open, 

what text to type). 

3.3 If you have forgotten how to perform some skills (e.g. choosing a screen layout, 

doing Send/Receive) then refer back to the procedure instructions given in the 

previous modules. Use the Table of Contents at the front of this handbook to help 

you find the procedure you need. Or use the summaries at the end of the modules. 

3.4 5ƻƴΩǘ ŦƻǊƎŜǘ ǘƻ ǇǊŀŎǘƛǎŜ ǳsing these key combinations: 

¶ Copy SELECTed text. Ctrl + C 

¶ Paste copied text. Ctrl + V 

¶ Delete selected text. Backspace or Delete 

¶ Change selected text. Type new wording while text is highlighted. 

¶ Undo a mistake. Ctrl + Z 

Read the Outline of procedure together out loud. 

Tutor explains clearly how to use the Specific instructions. 

Because this is the first simulation, the students will probably need help to open the correct files, 

choose the screen layout and enter the text into the correct place. 

As the students work, tutor checks that they are doing each step correctly, and gives help as required. 
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Outline of procedure  

1. Open Paratext. 

2. If necessary, do these things: 

¶ Open your project. 

¶ Open the resources you need. 

¶ Arrange the project and resource windows. 

3. Do Send/Receive  to a flash drive. 

4. Find the book/chapter/verse point in your project where you need to 

start typing. 

5. Type your translation into your project. Put the cursor at the start of each 

verse (after the verse number marker) and then type the words for that 

verse. 

6. Save your work regularly by pressing Ctrl  + S. 

7. When you finish your work session, save your work again. Then perform 

Send/Receive . 

3ɀ2 Specific instructions  

3.5 For this simulation, use the practice project Tok Pisin simulation project (TPSP). 

Open the resources Good News Translation 1994 (GNTUK) and New International 

Version US 1984 (NIV84). Choose the screen layout Stacked 3 Column. 

3.6 Notice that the practice project already has all the verse numbers listed. ̧ ƻǳ ŘƻƴΩǘ 

need to type those. Just type the translation text. 

3.7 ¸ƻǳ ǿƛƭƭ ōŜ ΨǘǊŀƴǎƭŀǘƛƴƎΩ John 15:1-5. This is the text that you need to type (it comes 

from the Tok Pisin Bible 1999): 

1 Mi yet mi diwai wain tru. Na Papa bilong mi em i papa bilong gaden wain. 

2 Olgeta han bilong mi i no save karim kaikai, em Papa i save rausim. Na olgeta han i 

save karim kaikai, em Papa i save rausim ol lip samting bilong en i nogut, na mekim 

em i kamap klin, bai em i ken karim planti kaikai. 

3 Yupela i kamap klin pinis. Dispela tok mi givim yupela, em i mekim yupela i kamap 

klin. 
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4 Yupela i mas pas long mi, na bai mi pas long yupela. Sapos han bilong diwai wain em 

i no pas long diwai, orait em i no inap karim kaikai. Olsem tasol, sapos yupela i no 

pas long mi, yupela tu i no inap karim kaikai.  

5 Mi yet mi diwai wain, na yupela i han bilong diwai wain. Man i pas long mi na mi pas 

long em, em i save karim planti kaikai. Sapos yupela i lusim mi, yupela i no inap 

mekim wanpela samting.  

3ɀ3 Debrief  

Class discussion. 

3.8 After everybody has completed the simulation, discuss what was easy and what was 

hard. What could you do without looking at the procedure instructions? What 

procedures did you need the instructions for? 
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4. Using markers  

Module outline  

In this module, you will learn: 

¶ what USFM markers are, what they look like and what they do; 

¶ how to enter a section heading into your translation text; 

¶ how to enter other kinds of markers; 

¶ how to change an existing marker. 

 

4ɀ1 What are markers?  

Class activity. 

4.1 We all know that Bible books are traditionally divided into chapters and verses, and 

there are numbers on the page to show where each chapter and verse starts. We 

need to mark these things in our translation project using markers. 

4.2 A MARKER is a short sequence of symbols and letters that indicates what part of the 

text we are looking at. You will usually see the markers while you work in Paratext, 

ōǳǘ ǘƘŜȅ ǿƻƴΩǘ ǎƘƻǿ ǳǇ ƛƴ ȅƻǳǊ Ŧƛƴŀƭ ǇǊƛƴǘŜŘ ǘǊŀƴǎƭŀǘƛƻƴΦ όIƻǿŜǾŜǊΣ ǘƘŜ ŜŦŦŜŎǘǎ ƻŦ 

them will be visible.) 

4.3 Watch part of the video Paratext7Editing.mp4 (or .html). You may need to click on 

Paratext7Editing_controller.swf to get it to play. Watch the section titled 

άLƴǘǊƻŘǳŎǘƛƻƴ ǘƻ ¢ŜȄǘ ǿƛǘƘ aŀǊƪŜǊǎέ όƛǘ ǎǘŀǊǘǎ ŀōƻǳǘ ллΥоп ǎŜŎƻƴŘǎ ƛƴǘƻ ǘƘŜ ŦƛƭŜ and 

ends about 2:24  into the fileύΦ 5ƻƴΩǘ ǿƻǊǊȅ ƛŦ ȅƻǳ ŘƻƴΩǘ ǳƴŘŜǊǎǘŀƴŘ ƳǳŎƘ ƻŦ ƛǘΗ As you 

watch, notice the symbols/abbreviations for some of the common markers. 

Tutor writes markers on the board as people mention them. Write the correct form even if the person 

says the wrong thing. 

4.4 ²Ƙŀǘ ƪƛƴŘǎ ƻŦ ƳŀǊƪŜǊǎ Ŏŀƴ ȅƻǳ ǘƘƛƴƪ ƻŦΚ 5ƻ ȅƻǳ ƪƴƻǿ ƻŦ ŀƴȅ ǘƘŀǘ ǿŜǊŜƴΩǘ ƳŜƴǘƛoned 

in the video clip? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

4.5 The narrator of the video called them USFM markers. USFM stands for Unified 

Standard Format Marker. This means that there is a list of standard markers that 
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Bible translation and publishing organisations have agreed to use. These standard 

markers are built into Paratext, and you will learn to use them too. 

4.6 What does a USFM marker always start with? 

 ..........................................................................................................................................................................  

4.7 Locate the BACKSLASH key \  on your keyboard. 

4.8 The marker ends with the next space (or occasionally with a punctuation mark). 

4.9 Here are some examples of common USFMs:  

¶ \ id comes at the start of a file and labels the content, i.e. what Bible book. Do 

not edit these. 

¶ \ c indicates the start of a new chapter (the marker is followed by the chapter 

number, such as \c 3). 

¶ \ p identifies the beginning of a new paragraph. 

¶ \ s indicates a section heading. 

¶ \ q marks the start of a line of poetry. 

¶ \ f \ f*  these two markers stand on either side of the contents of a footnote. 

4.10 hǇŜƴ tŀǊŀǘŜȄǘ όƛŦ ƛǘΩǎ ƴƻǘ ŀƭǊŜŀŘȅ ƻǇŜƴύΦ hǇŜƴ ǘƘŜ ǊŜǎƻǳǊŎŜ Tok Pisin Bible 1999 

(TBPU99). Remember that if you already have a resource window open, you can 

change it to show a different resource by SELECTing the new resource from the box on 

the TITLE BAR. 

 

4.11 Look at the text of the TBPU99Φ LŦ ȅƻǳ ŎŀƴΩǘ ǎŜŜ ŀƴȅ ƳŀǊƪŜǊǎΣ Ǝƻ ǘƻ ǘƘŜ View menu 

and choose Standard. 
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Class discussion, tutor writes correct answers on board. 

4.12 Dƻ ǘƻ ǘƘŜ ǎǘŀǊǘ ƻŦ aŀǊƪΩǎ DƻǎǇŜƭΦ [ƻƻƪ ŀǘ ǘƘŜ ŘƛŦŦŜǊŜƴǘ ŜƭŜƳŜƴǘǎ ǿƛǘƘƛƴ ǘƘŜ 

translation and the markers used to indicate them. See if you can locate the following 

markers: 

¶ a marker indicating the title Introduction at the start of the book; 

 ..................................................................................................................................................  

¶ a marker indicating the REFERENCES for PARALLEL PASSAGES; 

 ..................................................................................................................................................  

¶ a marker indicating background information about the translation. 

 ..................................................................................................................................................  

4.13 Write down 3 other markers that you can see in the introduction and first few verses. 

What do they indicate? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

Discuss usefulness of different markers. 

4.14 Put a TICK next to any markers in  4.12- 4.13 that you think you might use in your own 

translation project. 
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4ɀ2 Entering a section heading  

4.15 Your Paratext project will already be set up with all the chapter and verse markers in 

each book, as well as the \ id marker that starts each book. However, you will need to 

type the appropriate markers for all of the other text that you type in your 

translation. So we will practise entering markers into a project. 

4.16 ²ŜΩƭƭ ōŜ ǳǎƛƴƎ ǘƘŜ ǇǊŀŎǘƛŎŜ ǇǊƻƧŜŎǘ English Practice Project. Change the open 

resource window to show this project. 

Tutor prompts if anybody has already forgotten how! 

4.17 We will insert a section heading before Mark 1:9 that reads The Baptism of Jesus. 

Bring up Mark 1:8 in the project window. 

Tutor demonstrates, learners watch.  

Entering a section heading  

1. Insert the CURSOR where you want to put the section heading (find the 

book/chapter/verse location if necessary). Put it just before the verse 

marker. 

  

2. Press Enter . This brings up a box with all the possible markers. Notice 

that the BACKSLASH \  is already there at the top of the box. 
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3. Type the letter s. Notice how the list shortens so that it now only lists the 

markers that begin with s. 

 

4. Press Enter  to select the option Heading ɀ Section Level 1. Now the 

marker is entered in the right place in your project, and 

the cursor is placed where you need it to type in the 

section heading text. $ÏÎȭÔ ×ÏÒÒÙ ÔÈÁÔ ÔÈÅ ×ÒÉÔÉÎÇ ÌÏÏËÓ 

strange now. 
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5. Type your section heading text.  

6. Press Enter  again. Section headings need a paragraph marker after them 

to indicate that the body text of the section starts on a new line. 

7. Type p  to bring up Paragraph ɀ Normal ɀ First Line Indent in the list. 

 

8. Press Enter  to insert this marker into your text. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  

4.18 Practise entering this section heading into the sample project. First, place the cursor 

after the \v 8 verse marker. 

4.19 Now follow the Entering a section heading instructions to insert the heading. The 

text you need to type is The Baptism of Jesus. 

Learners practise independently. 

4.20 Now enter another section heading, The Temptation of Jesus, between verse 11 and 

verse 12 (i.e. it is the heading for the section beginning at verse 12). 

4.21 Now enter a section heading ¢ƘŜ .ŜƎƛƴƴƛƴƎ ƻŦ WŜǎǳǎΩ aƛnistry between verse 13 and 

verse 14. 

4ɀ3 Entering other markers  

4.22 Now we will practise entering some other kinds of markers. 

4.23 Enter another paragraph marker before the start of verse 6 (INSERT the cursor just 

before the \v 6 marker). 

Tutor demonstrates, learners watch.  

Entering a marker  

1. Insert the CURSOR where you need to put the MARKER (find the 

book/chapter/verse location if necessary). 

2. Press Enter . This brings up a box with all the possible markers. Notice 
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that the BACKSLASH \  is already there at the top of the box. 

 

3. SCROLL ÔÈÒÏÕÇÈ ÔÈÅ ÌÉÓÔ ÔÏ ÆÉÎÄ ÔÈÅ ÍÁÒËÅÒ ÙÏÕ ÎÅÅÄȢ "ÕÔ ÉÔȭÓ Á ÖÅÒÙ ÌÏÎÇ 

list! If you type the first letter of the marker you want, the list will shorten 

for you. 

4. Click on the marker that you want. Now the marker is entered in the right 

place in your project. 

5. If applicable, type in the text that you need. 

Tutor demonstrates, learners perform each step of demonstration after the tutor. 

Learners practise independently. 

4.24 Enter more paragraph markers at the start of verse 16 and verse 19. 

4.25 Enter a PARALLEL PASSAGES REFERENCE following the heading The Baptism of Jesus (place 

the cursor at the end of the line containing the heading). Use the marker \ r for 

Heading ς Parallel References. The text is (Matthew 3.13-17; Luke 3.21,22). 

4.26 Enter some poetry in verse 3. This time you need to insert the cursor at the start of 

the line before the \v 3 marker. The marker is \q1 for Poetry ς Indent Level 1. 
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4.27 Enter another poetry marker (\q1) in verse 2. This time you need to insert the cursor 

before the opening quote mark of άDƻŘ ǎŀƛŘ ... 

4ɀ4 Changing markers  

Class discussion. 

4.28 Sometimes you may need to change an existing marker. What are some reasons why 

you might need to do this? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

Tutor demonstrates  4.29 -  4.38, learners perform each step of demonstration after the tutor. 

4.29 Open the project Tok Pisin simulation project (use a window that is already open!). If 

ȅƻǳ ŎŀƴΩǘ ǎŜŜ ŀƴȅ ƳŀǊƪŜǊǎΣ Ǝƻ ǘƻ ǘƘŜ View menu and choose Standard. 

4.30 Go to 1 Thessalonians 1:3. Notice how the incorrect marker is a red 

colour to tell you it is wrong. What is wrong with this verse? 

 ..........................................................................................................................................................................  

4.31 Place the cursor just to the right of the BACKSLASH \  and type v. Paratext automatically 

recognises this as a verse marker now, and adjusts the text accordingly. 

4.32 Before verse 2 is a section heading, but it has the wrong marker. What should the 

marker be? 

 ..........................................................................................................................................................................  

4.33 Change the incorrect marker to the correct one (SELECT the part of the marker that is 

wrong, then type the correct letter). 

4.34 Verse 1 should be divided into two paragraphs. Insert a paragraph marker just before 

the sentence that begins God i ken marimari. What is the marker for a new 

paragraph? 

 ..........................................................................................................................................................................  

4.35 SCROLL up to the very beginning of the file. Here there is a title heading that marks the 

beginning of the whole book of 1 Thessalonians. This heading reads Namba wan pas 
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Pol i raitim long Ol Tesalonaika. It is split over two lines, because it is too long for one 

line. Notice how both lines have the same marker in front of them, and they both 

look the same (big, bold letters). 

 

4.36 We want the first half of the title to not look quite as important as the second line. 

We will change the markers of both these lines to read \mt1 (the main title, Ol 

Tesalonaika) and \mt2 (the extra information, Namba wan pas Pol i raitim long). 

4.37 Insert the cursor in the first line just after the marker \mt (before the space). 

4.38 Now type 2, so that the marker now reads \mt2. Notice how the line of text 

automatically reformats itself to look different to the second line. 

4.39 Now insert the cursor in the second line just after the marker \mt (before the space). 

4.40 Type 1, so that the marker now reads \mt1. The appearance of the words on the 

ǎŎǊŜŜƴ ǇǊƻōŀōƭȅ ǿƻƴΩǘ ŎƘŀƴƎŜ. But the different markers will have an effect when the 

text is typeset.  

4ɀ5 Markers tell us what something is, not how it should 

look when printed  

4.41 This is an important concept: USFM markers tell us what part of the text we are 

looking at, for example, a section head or a verse number. They do not tell us how 

the section head or the verse number should look when it is printed. That is a 

decision that is made by the typesetter. When we typeset our Scriptures, we may 

want to have bold verse numbers or we may not want them bold. We may want our 

section heads to be both bold and italic, or maybe just bold.  

4.42 ²ƘŜƴ ǿŜ ŀǊŜ ǿƻǊƪƛƴƎ ƛƴ tŀǊŀǘŜȄǘΣ ǿŜ ŘƻƴΩǘ ƘŀǾŜ ǘƻ ǿƻǊǊȅ ŀōƻǳǘ ǘƘƻǎŜ ŘŜŎƛǎƛƻƴǎΦ hǳǊ 

job as translators is to mark the verse numbers, section heads and other things based 

on what they are, not on how we want them to look. When we are working in 

Paratext, Paratext does try to make the translation look nice for us, but we should 

never change one marker to a different marker because we like the way it makes our 

translation look in Paratext.  

4.43 ²Ŝ ŀƭǎƻ ƴŜǾŜǊ ǘǊȅ ǘƻ ƳŀǊƪ ǎƻƳŜǘƘƛƴƎ ŀǎ άōƻƭŘέ ƻǊ άƛǘŀƭƛŎΦέ ¢ƘƻǎŜ ŀǊŜ ƴŀƳŜǎ ŦƻǊ ǿƘŀǘ 

something looks like. We only mark things in Paratext for what they are, not for how 

we think they should look.  
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4ɀ6 Review  

4.44 This module has introduced you to USFM MARKERS that can be used in your 

translation. 

Students fill in the answers, then tutor gives the correct answers. 

4.45 All USFM markers start with a  ΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦ  . 

4.46 The job of a marker is to    ΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ.  . 

4.47 In module  7 (Checking your text for basic mistakes) we will ƭŜŀǊƴ ǘƻ ǳǎŜ tŀǊŀǘŜȄǘΩǎ 

checking FUNCTIONS to ensure that the markers in our project are correct. 

4.48 In module  16 0 (More on markers) we will learn how to insert a FOOTNOTE using 

markers. 
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Module summary  

This module has shown how you can: 

Task Summary of steps Page 

Enter a marker. 

1. Insert the CURSOR where you want the marker. 

2. Press Enter to bring up the list of all possible markers. 

3. SCROLL through the list to find the marker you need 

όǎƘƻǊǘŜƴ ǘƘŜ ƭƛǎǘ ōȅ ǘȅǇƛƴƎ ǘƘŜ ƳŀǊƪŜǊΩǎ ŦƛǊǎǘ ƭŜǘǘŜǊύΦ 

4. Click on the marker that you want. 

41 

Enter a section 

heading. 

1. Insert the CURSOR where you want the heading. 

2. Press Enter, then s, then Enter (this enters the section 

heading marker). 

3. Type your section heading text. 

4. Press Enter again, then p, then Enter (this inserts a 

paragraph marker after the heading). 

39 

Change an existing 

marker. 

Use normal text EDITing skills: 

¶ insert the cursor and type extra CHARACTERS; or 

¶ select some text and type to change existing 

characters. 

43 
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5. Mark Point in Project History  

Module outline  

In this module, you will learn how to: 

¶ taƪŜ ǊŜƎǳƭŀǊ ΨǇƘƻǘƻǎΩ ƻŦ ȅƻǳǊ ǇǊƻƧŜŎǘ to record what it looks like at important points. 

 

5ɀ1 Motivation (drama)  

Two tutors act out the drama. 

Person #1: Good to see you today. Are you feeling better than yesterday? 

Person #2: ¸ŜǎΣ ǘƻŘŀȅ LΩƳ ōŜǘǘŜǊΦ 

Person #1: I had a good day yesterday, I worked on Luke chapter 3 and made some 

improvements. 

Person #2: Oh, did you make a list of the changes? 

Person #1: No, I just typed them straight onto the computer. 

Person #2: OhΧ (looks worried) Χbut I printed out chapter 3 yesterday, took it home 

with me, and made some changes. 

Person #1: [ŜǘΩǎ Ŏŀƭƭ our team leader.  

Person #2  (talks on phone) Χ hello sir! ΧLΩƳ ŦƛƴŜΦ Iƻǿ ƛǎ ȅƻǳǊ ŦŀƳƛƭȅΚ Χ Good. Oh, you 

have made some suggestions for footnotes in our translation? Which 

chapter? Oh, chapter 3! (looks more worried)? OhΧsir, I think we might have 

a problemΧ 

Class discussion, tutor writes responses on board. 

5.1 What problem is person #2 worried about? 

 ..........................................................................................................................................................................  

5.2 Working together in teams has many advantages. But it can be confusing if different 

people are working on different tasks. 

¶ What if different people make changes to the same text on different computers? 

²ƘƛŎƘ ƛǎ ǘƘŜ ΨƳŀǎǘŜǊ copyΩ? 

¶ If the consultant is making suggestions on her computer, and I am making 

changes on my computer, which one is ǘƘŜ ΨƳŀǎǘŜǊ ŦƛƭŜΩΚ 
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¶ What if someone changed a chapter, but then we want to know what was 

written before the changes? 

5.3 Thankfully, Paratext is very good at sharing, and very good at remembering. It can 

help us with these problems! 

5ɀ2 What is Mark Point in Proje ÃÔ (ÉÓÔÏÒÙȣ ? 

5.4 As your children grow up, they change. If you have a camera, you can take photos of 

ǘƘŜƳ ŀǎ ōŀōƛŜǎΣ ǘƻŘŘƭŜǊǎΣ ǎŎƘƻƻƭŎƘƛƭŘǊŜƴΣ ǘŜŜƴŀƎŜǊǎΣ ƎŜǘǘƛƴƎ ƳŀǊǊƛŜŘΧ ¢ƘŜƴ ȅƻǳ Ŏŀƴ 

look back at those photos and remember what they looked like at different ages of 

their life. 

INSERT IMAGE ςfamily photos 

5.5 tŀǊŀǘŜȄǘ ŀƭǎƻ Ƙŀǎ ŀ ǿŀȅ ƻŦ ǘŀƪƛƴƎ ΨǇƘƻǘƻǎΩ ƻŦ ȅƻǳǊ ǘǊŀƴǎƭŀǘƛƻƴ ǇǊƻƧŜŎǘ ŀǎ ƛǘ ΨƎǊƻǿǎ ǳǇΩΦ 

It is called aŀǊƪ tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ LŦ ȅƻǳ ŀǊŜ ŎŀǊŜŦǳƭ ŀōƻǳǘ ǘŀƪƛƴƎ ΨǇƘƻǘƻǎΩ 

using this FUNCTION, you will be able to see what changes have been made at various 

stages of the project. IǘΩǎ even possible to undo changes so that you put your project 

ōŀŎƪ ǘƻ ǘƘŜ ǿŀȅ ƛǘ ǿŀǎ ōŜŦƻǊŜΦ ό¸ƻǳ ŎŀƴΩǘ Řƻ ǘƘƛǎ ǿƛǘƘ ŎƘƛƭŘǊŜƴΗύ 

5.6 ¸ƻǳ Ŏŀƴ ǘŀƪŜ ŀ ΨǇƘƻǘƻΩ ƻŦ ǘƘŜ ǇǊƻƧŜŎǘ before and after any major changesΦ ¸ƻǳ ŘƻƴΩǘ 

need to take a photo after little changes, only after big changes. For example: 

¶ before starting a new chapter; 

¶ after typing a chapter; 

¶ before making advisor check changes; 

¶ after making advisor check changes. 

Class discussion, tutor writes suggestions on board. 

5.7 ²ƘŜƴ ŜƭǎŜ ǿƻǳƭŘ ƛǘ ōŜ ƎƻƻŘ ǘƻ ǘŀƪŜ ŀ ΨǇƘƻǘƻΩ ƻŦ ȅƻǳǊ ǇǊƻƧŜŎǘΚ 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

5ɀ3 Using -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ 

5.8 Open the project English Practice Project and go to James 1:1. 
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5.9 The first few verses of chapter 1 have already been entered. However, other 

members of your team have looked through these verses and identified some 

changes that need to be made. 

5.10 .ŜŦƻǊŜ ȅƻǳ ƳŀƪŜ ǘƘŜ ŎƘŀƴƎŜǎΣ ȅƻǳ ǿƛƭƭ ǘŀƪŜ ŀ ƘƛǎǘƻǊȅ ΨǇƘƻǘƻΩ ƛƴ ŎŀǎŜ ȅƻǳ ƴŜŜŘ ǘƻ 

refer back to the previous state of the project. 

5.11 The photo also needs a name that accurately describes it. If you are about to make 

big changes, the name should say what big changes you are about to make. 

5.12 We are going to make some changes to James 1, so weΩƭƭ Ŏŀƭƭ ǘƘŜ ΨǇƘƻǘƻΩ Before error 

corrections in James 1. 

Tutor demonstrates, learners watch.  

Taking a -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ Ȭphotoȭ 

1. Go to the Project  menu and choose -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ 

 

2. This opens the Mark Point in Project History window. In the box labelled 

Commentȟ ÔÙÐÅ Á ÎÁÍÅ ÆÏÒ ÔÈÅ ȬÐÈÏÔÏȭ ÔÈÁÔ ÄÅÓÃÒÉÂÅÓ ÔÈÅ ÓÔÁÇÅ ÏÆ ÙÏÕÒ ÐÒÏÊÅÃÔ 

when you took it. This is a photo of the whole project, not just the book you 

are working on, so you should be very specific about which book and chapter 

you are about to work on and what changes you think you will make. 



50 last edited 30 June 2011 

 

3. Click on OK. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  

5.13 Now make the following changes to the text of James 1: 

¶ v1 ς capitalise lord 

¶ v1 ς change twelve to 12 

¶ v4 ς correct completly to completely 

¶ v5 ς correct it will given to it will be given 

¶ v9 ς insert full stop at end of sentence 

5.14 Take another photo. Call it Before entering section headings. 

5.15 Enter the following section headings: 

¶ before v2 ς Faith and Wisdom 

¶ before v9 ς Poor People and Rich People 

If you have forgotten how to enter a section heading, look back at Entering a section 

heading on page 39. 

Learners practise independently. 

5.16 Take another photo. Call it Before wording changes. 

5.17 Make the following changes: 

¶ v2 ς change trouble to problems 
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¶ v5 ς change punish to correct 

5.18 Now that you have finished making all the changes, take another photo. Call it After 

wording changes. 

5ɀ4 Comparing changes (demonstration ) 

5.19 The purpose of taking all these photos of your project is to let you compare ΨōŜŦƻǊŜΩ 

ŀƴŘ ΨŀŦǘŜǊΩΦ If you make changes but they turn out not to be good changes, you can 

look back at an earlier version of your project and decide if you want to go back to 

the way it was before. 

5.20 Sometimes this can rescue your project from a big mess, but if you are not careful in 

how you undo changes, you can make an even bigger mess. So at this point in the 

course we will not be learning how to undo changes! But we can still see a 

demonstration of how to do it, so we understand how useful the photos can be. 

¢ǳǘƻǊ ŘŜƳƻƴǎǘǊŀǘŜǎ ǘƘŜ /ƻƳǇŀǊŜ ¢ŜȄǘǎΧ ŦǳƴŎǘƛƻƴΦ /ƻƳǇŀǊŜ ǘƘŜ ŎǳǊǊŜƴǘ ǾŜǊǎƛƻƴ ǘƻ ǘƘŜ ǇƘƻǘƻ Ψ.ŜŦƻǊŜ 

ŜǊǊƻǊ ŎƻǊǊŜŎǘƛƻƴǎΩΦ Undo two changes: v1 revert 12 to twelve; v2 revert problems to trouble. 

5.21 It may be easier to take a aŀǊƪ tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ photo after you have made 

changes. You might name it something like After making corrections in Luke 3. 

5ɀ5 Review 

5.22 At the beginning of the class, we saw that the team got themselves in a mess 

because they had made different changes on the same verse. They needed a way to 

compare the changes they had made. 

5.23 LŦ ǘƘŜȅ ǳǎŜŘ tŀǊŀǘŜȄǘΣ ŀƴŘ ǘƻƻƪ ΨǇƘƻǘƻǎΩ ƻŦ ǘƘŜ ǇǊƻƧŜŎǘ ōŜŦƻǊŜ ŀƴŘ ŀŦǘŜǊ ǘƘŜȅ ƳŀŘŜ 

the changes, then it is easy to compare what was changed. 

5.24 When we work on a team, sometimes there will be confusion about who has made 

what change to a project. The best thing is to avoid getting confused! But if things do 

go wrong, Paratext can help you compare what has been changed, if you have been 

taking regular photos. 

5.25 Therefore, it is very important that you remember and remind each other to take 

photos before and after making big changes to the translation. 

5.26 What are some reasons for using aŀǊƪ tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ? 

 ..........................................................................................................................................................................  

5.27 ²Ƙŀǘ ŀǊŜ ǎƻƳŜ ƎƻƻŘ ǘƛƳŜǎ ǘƻ ǘŀƪŜ ŀ ΨǇƘƻǘƻΩ ƻŦ ȅƻǳǊ ǇǊƻƧŜŎǘΚ 

 ..........................................................................................................................................................................  
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Module summary  

This module has shown how you can: 

Task Summary of steps Page 

¢ŀƪŜ ŀ ΨǇƘƻǘƻΩ ǳǎƛƴƎ 

Mark Point in Project 

IƛǎǘƻǊȅΧ 

1. Go to the Project menu and choose Mark Point in 

tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ 

2. DƛǾŜ ǘƘŜ ΨǇƘƻǘƻΩ ŀ ŘŜǎŎǊƛǇǘƛǾŜ ƴŀƳŜΦ 

3. Click on OK. 

49 
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6. Practice session 2 (simulation)  

Module outline  

In this module you will perform a simple SIMULATION of working on a Bible translation, using 

the skills you have learnt so far. 

 

6ɀ1 Introduction  

6.1 This simulation is quite simple but it builds on the first one by incorporating the new 

skills you have learnt since then: inserting markers, and taking a Mark Point in Project 

IƛǎǘƻǊȅΧ ΨǇƘƻǘƻΩΦ 

6.2 Follow the instructions below to create a mini-translation in Tok Pisin. Remember to 

use the general Outline of procedure instructions below and also the Specific 

instructions  for this simulation. 

6.3 You need to pretend that this work takes place over several weeks or months. That is 

why you need to do Send/Receive and aŀǊƪ tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ several times. 

6.4 If you have forgotten how to perform some skills, refer back to the procedure 

instructions given in the previous modules. Use the Table of Contents at the front of 

this handbook to help you find the procedure you need. Or use the summaries at the 

end of the modules. 

Read the Outline of procedure together out loud. 

Tutor explains clearly how to use the Specific instructions. 

As the students work, tutor checks that they are doing each step correctly, and gives help as required. 

Outline of procedure  

1. Open Paratext. 

2. If necessary, do these things: 

¶ Open your project. 

¶ Open the resources you need. 

¶ Arrange the project and resource windows. 

3. Do Send/Receive  to a flash drive. 

4. Take a -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ ȬÐÈÏÔÏȭ ÁÎÄ ÇÉÖÅ ÉÔ Á ÓÕÉÔÁÂÌÅ ÎÁÍÅȢ 
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5. Find the book/chapter/verse point in your project where you need to 

start typing. 

6. Type your translation into your project. 

7. Save your work regularly by pressing Ctrl  + S. 

8. When you finish entering the text, save your work again. Then take 

another -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ photo. 

9. Now check your work carefully for typing errors, and make any 

corrections needed. 

10. Save your work again, then take another Mark Point in Project 

(ÉÓÔÏÒÙȣ photo. 

11. Perform Send/Receive . 

12. Some time passes and your team has decided on certain changes to the 

passage. Take another Mark Point ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ photo. 

13. Make the changes. 

14. Save your work. Take another -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ photo. 

15. Then perform Send/Receive . 

16. Close Paratext. 

6ɀ2 Specific  instructions  

6.5 For this simulation, use the sample project Tok Pisin simulation project. Open the 

resource New English Translation (NET Bible) 1996. Choose the screen layout 

Stacked 2 Column. 

6.6 ¸ƻǳ ǿƛƭƭ ōŜ ΨǘǊŀƴǎƭŀǘƛƴƎΩ Matthew 6:5-13. If you do not need practice in typing, you 

can copy these verses from the Tok Pisin Bible (TPBU99) and paste them into your 

practice project. Make sure both projects are using Standard View. If you would 

rather type, this is the text (it comes from the Tok Pisin Bible 1999): 

 5 Jisas i tok Ƴƻŀ ƻƭǎŜƳΣ ά¢ŀƛƳ ȅǳǇŜƭŀ ƛ mekim prea, yupela i no ken mekim olsem ol 

man bilong giaman i save mekim. Ol i laikim tumas long sanap na mekim prea insait 

long ol haus lotu, na long ol kona bilong bikrot, bai ol man i ken lukim ol. Mi tok tru 

long yupela, ol i kisim pinis pe bilong ol. 



Module  6: Practice session 2 (simulation) 

last edited 30 June 2011 55 

 6 Tasol taim yu laik mekim prea, yu mas i go insait long haus bilong yu na pasim dua 

na beten long Papa bilong yu i stap long ples hait. Na Papa bilong yu i save lukim ol 

samting i stap hait, em bai i bekim pe long yu. 

 7 άbŀ ǘŀim yupela i mekim prea, maski long mekim planti toktok nating, olsem ol 

haiden i save mekim. Ol i ting sapos ol i mekim planti toktok bai God i harim. 

 8 Yupela i no ken bihainim pasin bilong ol. Taim yupela i no opim maus yet long askim 

Papa bilong yupela long wanpela samting, em i save pinis long olgeta samting 

yupela i sot long en. 

 9 ά¸ǳ Ƴŀǎ ƳŜƪƛƳ ƪŀƛƴ ǇǊŜŀ ƻƭǎŜƳΣ tŀǇŀ ōƛƭƻƴƎ ƳƛǇŜƭŀΣ ȅǳ ǎǘŀǇ ƭƻƴƎ ƘŜǾŜƴΣ ƴŜƳ 

bilong yu i mas i stap holi. 

 10 Kingdom bilong yu i mas i kam. Mipela i mas bihainim laik bilong yu long graun 

olsem ol i save bihainim long heven. 

 11 Nau yu ken givim mipela kaikai inap long dispela de. 

 12 Na yu ken lusim ol rong bilong mipela, olsem mipela i save lusim ol rong ol arapela i 

mekim long mipela. 

 13 Na yu no ken larim ol traim i kamap long mipela, tasol yu ken kisim bek mipela long 

ol samting nogut.έ 

6.7 Changes to make following the team review (step  12): 

¶ insert heading before v5 ς Jisas i tok long pasin bilong mekim prea 

¶ v6 ς change haus to rum 

¶ v7 ς start a new paragraph before this verse 

¶ v7 ς insert ol after harim 

¶ v9 ς start a new paragraph before this verse 

¶ v9 ς change yu to yupela i 

¶ before ΨtŀǇŀ bilong mipela ς insert \q1 marker to start a line of poetry 

¶ also insert \q1 ŀǘ ǘƘŜ ǎǘŀǊǘ ƻŦ ŜŀŎƘ ǎŜƴǘŜƴŎŜ ǘƘǊƻǳƎƘ ǘƻ ǘƘŜ ŜƴŘ ƻŦ ǘƘŜ [ƻǊŘΩǎ 

Prayer (v.13) ς 5 times. 

6ɀ3 Debrief  

Class discussion. 

6.8 After everybody has completed the simulation, discuss what was easy and what was 

hard. What could you do without looking at the procedure instructions? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  
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6.9 What procedures did you need the instructions for? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

6.10 Did you understand why you needed to do certain procedures at certain stages of the 

process (e.g. taking a ΨǇƘƻǘƻΩ ƻŦ ǘƘŜ ǇǊƻƧŜŎǘΣ ŘƻƛƴƎ {ŜƴŘκwŜŎŜƛǾŜΧ)? Were there any 

ǎǘŜǇǎ ǘƘŀǘ ȅƻǳ ŘƛŘƴΩǘ ǎŜŜ ǘƘŜ ǇǳǊǇƻǎŜ ƻŦΚ 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

6ɀ4 Self-evaluation  

6.11 At this point in the course it is worth stopping to check that you have understood 

everything we have covered so far. Please complete the following skills list. 

¶ TICK ǘƘŜ άYesέ ŎƻƭǳƳƴ ƛŦ ȅƻǳ can complete this task without even looking at the 

instructions. 

¶ Tick ǘƘŜ άInstructionsέ column if you can complete the task by following the 

instructions. 

¶ Tick ǘƘŜ άbƻέ column if you can only complete this task ǿƛǘƘ ǎƻƳŜōƻŘȅΩǎ ƘŜƭǇ.  

Skill Yes Instructions No 

Open and close Paratext.    

Open a project or resource (in a new window).    

Change the resource that a window is 

displaying. 
   

Arrange windows into three columns.    

Move a window.    

Change the size of a window.    

Find a specific book/chapter/verse in a 

resource. 
   

SELECT text.    

DELETE selected text.    

Copy selected text.    

Paste copied text.    
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Skill Yes Instructions No 

Undo a mistake you just made.    

Save your work quickly.    

Recognise a USFM MARKER.    

Start a new paragraph in your text (by 

inserting a paragraph marker). 
   

Insert a section heading.    

¢ŀƪŜ ŀ ΨǇƘƻǘƻΩ ƻŦ ȅƻǳǊ ǇǊƻƧŜŎǘΦ    

Share your work with a team member on a 

FLASH DRIVE (Send/Receive). 
   

 

6.12 Is there anything you would like the tutor to review with you at this point? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

Tutor passes around pieces of paper. 

6.13 Please write down the topics that you would like to review now. 

Tutor collects papers. 
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7. Checking your text for basic mistakes 

Module outline  

In this module, you will learn how to: 

¶ check that your text has no missing chapters or verses; 

¶ check that your text has no incorrect markers. 

 

7ɀ1 Motivation  (discussion)  

7.1 Over the centuries, printers have made a lot of costly mistakes when printing the 

Bible. For example: 

¶ άVinegar Bibleέ (1717): The chapter heading for Luke 20 reads άThe Parable of 

the Vinegarέ instead of άThe Parable of the Vineyardέ. 

¶ άWicked Bibleέ, άAdulterous Bibleέ or άSinner's Bibleέ (1631): It omits an 

important άnotέ from Exodus 20:14, making the seventh commandment read 

άThou shalt commit adulteryέ. The printers were fined a lot of money and most 

of the copies were recalled immediately. 

Class discussion, tutor writes suggestions on board. 

7.2 Have you ever noticed a mistake in a printed book? What kinds of mistakes have you 

noticed? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

7.3 In order for your text to communicate the message clearly, it needs to be complete, 

free from typing mistakes and correctly FORMATTED. Paratext has some powerful tools 

to help you check your text for mistakes. These checks allow you to be sure that all 

the chapters and verses are present and help you to find typing mistakes such as 

incorrect letters, punctuation, capitalisation, etc. You can also check the markers 

used to apply formatting. Some of these checks are good to use early on in your 

translation process. If you miss a verse, it is important to find out before the 

consultant check. 

7.4 What sort of errors do you need to check for in your project? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  
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7.5 tŀǊŀǘŜȄǘΩǎ wǳƴ .ŀǎƛŎ /ƘŜŎƪǎΧ FUNCTION checks the following things: 

¶ Chapter/Verse Numbers 

¶ Markers 

¶ Characters 

¶ Punctuation 

¶ Capitalization 

¶ Repeated Words 

¶ Matched Pairs 

¶ Quotations 

7.6 In this module we will only be looking at the first two checks, Chapter/Verse Numbers 

and Markers. We will cover the other five later, as they require some advanced 

preparation to work properly. 

7.7 Paratext also has a SPELLCHECKER, but this is also an advanced FUNCTION and it will be 

taught later too. 

7.8 The first time you check for mistakes, it is best to do only one check at a time in case 

there is a long list of errors (i.e. ŘƻƴΩǘ Řƻ all the possible checks simultaneously). 

7.9 It is important to run the Chapter/Verse Numbers check first, as all other checks 

depend on it. This check is used to make sure that all the chapter and verse markers 

are correct. If the verse numbers are incorrect, then Paratext has trouble locating 

other errors. 

7ɀ2 Review: USFM markers 

Class discussion. 

7.10 All USFM MARKERS start with a  ΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ . 

7.11 The job of a marker is to  ΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ . 

7.12 Some markers that we have used already are: 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

7ɀ3 Checking for missing chapters or verses  

7.13 Start by opening the project English Practice Project. We will be checking the book of 

Matthew. It has a lot of mistakes in it!  
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Tutor demonstrates, learners watch. Then the tutor needs to revert to the earlier form of the text to 

repeat the demonstration.  

Checking for missing chapters or verses  

1. Make sure your project window is SELECTed. 

2. )Æ ÙÏÕ ÃÁÎȭÔ ÓÅÅ ÁÎÙ ÍÁÒËÅÒÓ ÉÎ ÔÈÅ ÔÅØÔȟ ÇÏ ÔÏ ÔÈÅ View  menu and choose 

Standard . 

3. Take a -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ photo and give it a suitable name. 

This needs to include the name of the Bible book that you will be checking. 

4. Go to the Bible book that you want to check. 

5. From the Checking menu, choose 2ÕÎ "ÁÓÉÃ #ÈÅÃËÓȣ 

 

6. In the section of the window labelled Check, UNTICK all the boxes 

except for the one labelled Chapter/Verse Numbers. This box needs to 

have a TICK in it. 
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7. Select Current Book and make sure that the name of the book you want to 

check is next to it. 

8. Click on OK. 

9. A new window opens up with the list of mistakes in it. 

 

10. To go to a verse with a mistake, DOUBLE-CLICK on that row of the list. 

11. Fix the mistake (or confirm that the text is correct). 
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12. Press Ctrl  + S to save the file. 

13. Double-click on the next item in the list to go to the next mistake. 

14. Continue until every item is dealt with. 

15. Run the Chapter/Verse Numbers ÃÈÅÃË ÁÇÁÉÎȟ ÔÏ ÅÎÓÕÒÅ ÔÈÁÔ ÙÏÕȭÖÅ ÆÉØÅÄ 

all the problems. 

Tutor demonstrates, learners perform each step of demonstration after the tutor. Name the Mark 

tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ ǇƘƻǘƻ Ψ.ŜŦƻǊŜ /ƘŀǇǘŜǊκ±ŜǊǎŜ Ŏheck in MatthewΩΦ  

Class discussion.  

7.14 What kind of mistakes did you need to correct? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

7.15 bƻǘŜ ǘƘŀǘ ǎƻƳŜ ƻŦ ǘƘŜ ΨƳƛǎǘŀƪŜǎΩ ŘƻƴΩǘ ŀŎǘǳŀƭƭȅ ƴŜŜŘ ŎƻǊǊŜŎǘƛƴƎΦ Some verses have 

been deliberately omitted from the main text because scholars think they may have 

been added by a later scribe. In the practice project, these verses already have a 

footnote to mark them. We will learn about inserting footnotes in a later module. 

7ɀ4 Checking for incorrect markers  

7.16 Next we need to check for incorrect MARKERS. 

7.17 The procedure is exactly the same as the Checking for missing chapters or verses 

check, except that this time you need to have the Markers box ticked (UNTICK the 

Chapter/Verse Numbers box). 

 

7.18 !ŦǘŜǊ ȅƻǳΩǾŜ ŎƻǊǊŜŎǘŜŘ ŀƭƭ ǘƘŜ ƳƛǎǘŀƪŜǎΣ ŘƻƴΩǘ ŦƻǊƎŜǘ ǘƻ Ǌǳƴ ǘƘŜ Markers check again 

to confirm that all the mistakes have been fixed. 
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Tutor demonstrates, learners watch. Then the tutor needs to revert to the earlier form of the text to 

repeat the demonstration. 

Tutor demonstrates, learners perform each step of demonstration after the tutor. Name the Mark 

tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ ǇƘƻǘƻ Ψ.ŜŦƻǊŜ Markers ŎƘŜŎƪ ƛƴ aŀǘǘƘŜǿΩΦ 

Class discussion. 

7.19 What kind of mistakes did you need to correct? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

7ɀ5 More practice  

Class activity (encourage discussion to solve problems). See Appendix for solutions. 

7.20 It only takes a little mistake with the markers to make a big mess of your project! For 

example, what if someone accidentally deletes a chapter marker? In this next 

exercise you will see what that looks like.  

7.21 Go to the book of Titus in the English Practice Project. 

7.22 Open another Bible resource as well. This will give you something to check against if 

ȅƻǳ ŎŀƴΩǘ ǳƴŘŜǊǎǘŀƴŘ ǿƘȅ ǎƻƳŜǘƘƛƴƎ ƛǎ ƭƛǎǘŜŘ ŀǎ ŀ ƳƛǎǘŀƪŜΦ aŀƪŜ ǎǳǊŜ ȅƻǳ Ŏan see 

the markers in this resource. (How do you do that?) 

7.23 Perform a Chapter/Verse Numbers check on the sample project (Titus only). 

7.24 How can you fix the first mistake (Duplicated verse: 1:4)? IƛƴǘΥ ŘƻƴΩǘ ŀǎǎǳƳŜ ǘƘŀǘ 

verse 4 is the problem! SCROLL through the whole chapter to see if the mistake might 

be somewhere else. 

 ..........................................................................................................................................................................  

7.25 hƴŎŜ ȅƻǳΩǾŜ ŦƛȄŜŘ ǘƘŜ ŦƛǊǎǘ ƳƛǎǘŀƪŜΣ Ǌǳƴ ǘƘŜ Chapter/Verse Numbers check again to 

confirm that you made the right change. Notice that some of the other mistakes in 

the list have disappeared because you fixed that first mistake. 

7.26 What do you need to do to fix the next mistake (Duplicated verse: 2:1)? Hint: once 

again, the problem is not with verse 2:1! Compare the text of English Practice Project 

to the other resource that you opened, and see if you can spot something important 

that is missing.    

7.27 In order to fix this mistake, you need to have all the chapters of Titus flowing one 

after the other. Go to the View menu. Notice there is a command called By Chapter 
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that has a tick next to it. SELECT the command By Chapter ǘƻ ΨǎǿƛǘŎƘ ƛǘ ƻŦŦΩΦ bƻǿ ȅƻǳ 

will be able to SCROLL down through all the chapters of Titus together. 

 

7.28 Insert the important missing marker in the right place (put it before the section 

heading). 5ƻƴΩǘ ŦƻǊƎŜǘ ǘƻ Ǉǳǘ ǘƘŜ ŎƘŀǇǘŜǊ ƴǳƳōŜǊ too. 

7.29 hƴŎŜ ȅƻǳΩǾŜ ŦƛȄŜŘ ǘƘŀǘ ƳƛǎǘŀƪŜΣ Ǌǳƴ ǘƘŜ Chapter/Verse Numbers check again to 

confirm that you made the right change. Once again, some of the other mistakes in 

the list have disappeared too. 

7.30 What do you need to do to fix the next mistake (Verse(s) missing: 2:6)? 

 ..........................................................................................................................................................................  

7.31 If you try to insert a verse marker by pressing EnterΣ tŀǊŀǘŜȄǘ ŘƻŜǎƴΩǘ ƭŜǘ ȅƻǳΦ hƴŎŜ 

ȅƻǳΩǾŜ Ǉǳǘ ǘƘŜ ŎǳǊǎƻǊ ƛƴ ǘƘŜ ǊƛƎƘǘ ǇƭŀŎŜ όōŜŦƻǊŜ \ v 7), go to the Insert menu and 

choose Verse Number. Paratext inserts both the marker and the correct verse 

number. 

 

7.32 Run the Chapter/Verse Numbers check again. Notice there is still a mistake listed for 

verse 2:6. Type in a translation for this verse (refer to the open resource for help). 
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7.33 The next mistake should be straightforward to fix if you know about markers and 

what they should look like. 

 ..........................................................................................................................................................................  

7.34 It should be easy to see what needs fixing in the last mistake. But how do you get 

Paratext to do it? Hint: look back to  7.31. aŀƪŜ ǎǳǊŜ ȅƻǳ ŘƻƴΩǘ ƭŜŀǾŜ ŀƴȅ ǘŜȄǘ ƛƴ ǘƘŜ 

verse that shouldnΩǘ ōŜ ǘƘŜǊŜΦ 

 ..........................................................................................................................................................................  

7.35 Do one last Chapter/Verse Numbers ŎƘŜŎƪ ǘƻ ŎƻƴŦƛǊƳ ǘƘŀǘ ȅƻǳΩǾŜ ŦƛȄŜŘ ŀƭƭ ǘƘŜ 

mistakes. 

7.36 Now perform a Markers check. 

7.37 What caused the first mistake (Marker cannot occur here: \v)? Hint: what needs to 

come after each section heading? Fix the mistake. 

 ..........................................................................................................................................................................  

7.38 Perform another Markers check. The other mistakes should be straightforward to fix. 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

7.39 Do one last Markers ŎƘŜŎƪ ǘƻ ŎƻƴŦƛǊƳ ǘƘŀǘ ȅƻǳΩǾŜ ŦƛȄŜŘ ŀƭƭ ǘƘŜ ƳƛǎǘŀƪŜǎΦ 

7.40 Go to the View menu and choose By Chapter to put your project back to showing 

one chapter at a time. 

7.41 What have we learnt? We have learnt to be very careful not to accidentally change or 

delete chapter and verse numbers! It is much better not to make the mistake than to 

have to fix it up. 
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Module summary  

This module has shown how you can: 

Task Summary of steps Page 

Check for missing 

chapters or verses. 

1. SELECT your project window, and go to the Bible book 

you want to check. 

2. Take a aŀǊƪ tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ photo and give 

it a suitable name, including the Bible book you are 

checking. 

3. From the Checking menu, choose wǳƴ .ŀǎƛŎ /ƘŜŎƪǎΧ 

4. TICK the box labelled Chapter/Verse Numbers, and 

UNTICK all the others. 

5. Select Current Book and make sure that the name of 

the book you want to check is next to it. 

6. Click on OK. A new window opens up showing the list 

of mistakes. 

7. To go to a verse with a mistake, DOUBLE-CLICK on that 

row of the list. 

8. After you have fixed all the mistakes, run the 

Chapter/Verse Numbers check again. 

60 

Check for incorrect 

markers. 

¶ As above, but tick the Markers box instead of 

Chapter/Verse Numbers. 
62 

Enter a verse number 

marker. 

1. Insert the CURSOR where you need the marker. 

2. Go to the Insert menu and choose Verse Number. 
64 
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8. Printing  

Module outline  

In this module, you will learn how to: 

¶ print a Bible book from your project; 

¶ print only part of a book; 

¶ save a print-out file (PDF) to a flash drive for printing at another computer. 

 

8ɀ1 Motivation (discussion)  

Group discussion, tutor writes suggestions on board. The Appendix has some suggestions. 

8.1 In this module we will look at how to print out your translation. 

8.2 What are some reasons for printing out your translation? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

8.3 Before you print, you need to decide how much of your translation to print out. Do 

you want to print a single book, several books, or just part of a book? Making this 

decision will stop you from wasting paper, and also help you to choose the correct 

printing OPTIONS. 

8.4 There are several ways to print in Paratext, but the most straightforward is the Print 

5ǊŀŦǘΧ FUNCTION. This turns your translation project text into a PDF file. Then you 

print out the PDF file from the ADOBE READER program. 

8.5 A PDF is a way of saving your text that looks like a printed page, even when you see it 

on the computer screen. It has nice FORMATTINGΣ ŀƴŘ ȅƻǳ ǿƻƴΩǘ ǎŜŜ ŀƴȅ ƻŦ ǘƘŜ USFM 

MARKERS. When you print the PDF, the print-out on paper will look the same as what 

you see on the screen. 

8.6 tǊƛƴǘ 5ǊŀŦǘΧ lets you choose whether you want to print just one book, or more than 

one. ²ŜΩƭƭ Ƨǳǎǘ ƭƻƻƪ ŀǘ ǇǊƛƴǘƛƴƎ ŀ ǎƛƴƎƭŜ ōƻƻƪΦ 

8.7 If you want to print just part of a book, within Adobe Reader you can choose which 

pages to print. 

8.8 NoteΥ ȅƻǳ ŎŀƴΩǘ ǳǎŜ tǊƛƴǘ 5ǊŀŦǘΧ to print a resource. You can only print a project. 
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8ɀ2 Printing a book  for checking  

8.9 We will print out a single book (3 John) of English Practice Project for checking. We 

need extra sǇŀŎŜ ƻƴ ǘƘŜ ǇŀƎŜ ǘƻ ǿǊƛǘŜ ƴƻǘŜǎΣ ǎƻ ǿŜΩƭƭ use double line-spacing to put 

space between the lines of text. 

8.10 Most of the OPTIONS for printing (like A4 paper and the size of the writing) have 

ŀƭǊŜŀŘȅ ōŜŜƴ ǎŜǘΦ ²Ŝ ǿƻƴΩǘ ŎƘŀƴƎŜ ǘƘŜǎŜΦ 

Tutor demonstrates, learners watch.  

Printing a single book  

1. Open (or click in)  the project 

that you want to print from, 

and go to the book that you 

want to print. 

2. )Æ ÙÏÕ ÈÁÖÅÎȭÔ ÒÅÃÅÎÔÌÙ ÄÏÎÅ 

Chapter/Verse Numbers and 

Markers checks, do them now 

and make sure there are no 

mistakes in the book you want 

to print (see module  7 

Checking your text for basic 

mistakes ÉÆ ÙÏÕȭÖÅ ÆÏÒÇÏÔÔÅÎ 

how). 

3. Go to the File  menu and 

choose 0ÒÉÎÔ $ÒÁÆÔȣ  
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4. The following window displays: 

 

5. Check that the name of your project shows next to Project:. 

6. Check that Current Book is selected and shows the name of the book you 

want to print. 

7. In the Layout section, choose a 

Line Spacing OPTION. 

8. Click on OK. 

9. Wait patiently until Adobe Reader opens. It shows the nice FORMATTING of 

the book that you want to print. SCROLL through the file to the end to 

check that it contains everything that you want to print. 
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10. Within Adobe Reader, go to the File  menu and choose 0ÒÉÎÔȣ 

 

11. The Print window will open. 
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12. In the section labelled Printer, check that you can see the name of your 

printer.  

13. Click on OK. Your file should print. The print-out should look the same as 

what you see on the computer screen. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  

8.11 Collect your print-out from the printer and compare it to the PDF file on the screen. 

Compare it to the Paratext project too. Which is the easiest to read? 

 ..........................................................................................................................................................................  

8.12 This time we used double line-ǎǇŀŎƛƴƎΦ .ǳǘ ƛŦ ȅƻǳ ŘƻƴΩǘ ƴŜŜŘ ƭƻǘǎ ƻŦ ǎǇŀŎŜ ƻƴ ǘƘŜ 

print-out for notes, you can choose the Line Spacing: setting Single. 
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8ɀ3 Printing part of a book  

8.13 What if you onƭȅ ǿŀƴǘ ǘƻ ǇǊƛƴǘ ǇŀǊǘ ƻŦ ŀ ōƻƻƪΚ ¢Ƙƛǎ ǘƛƳŜ ǿŜΩƭl just print chapter 1 of 

Titus (from the English Practice Project). 

Tutor demonstrates, learners watch. /ƭƛŎƪ ƻƴ /ŀƴŎŜƭ ǊŀǘƘŜǊ ǘƘŀƴ hY ŀǘ ǘƘŜ ŜƴŘ ǎƻ ǘƘŀǘ ȅƻǳ ŘƻƴΩǘ 

actually print.  

Printing part of a book  

1. Follow the Printing a single book instructions until you get to step  9. 

SCROLL through the PDF file and decide which pages you need to print to 

get all the text you want. (Note: the page numbers are at the top right of 

each page, except the first one.) 

 

2. Within Adobe Reader, go to the File  menu and choose 0ÒÉÎÔȣ The Print 

window will open. 

3. In the section labelled Printer, check that you see the name of your printer. 

4. In the section Print Range, select Pages and type in the numbers of the 

pages that you want to print: 

¶ consecutive pages, e.g. 

1-6  (first page number, 

hyphen, last page 

number); 

¶ non-consecutive pages, 

e.g. 1, 6, 12-15. 

 

5. Click on OK. Your file should print. The print-out should look the same as 

what you see on the computer screen. 
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Tutor demonstrates, learners perform each step of demonstration after the tutor. Click on Cancel 

ǊŀǘƘŜǊ ǘƘŀƴ hY ŀǘ ǘƘŜ ŜƴŘ ǎƻ ǘƘŀǘ ȅƻǳ ŘƻƴΩǘ ŀŎǘǳŀƭƭȅ ǇǊƛƴǘΦ  

8.14 How many pages did you need for Titus ch.1? How did you type it into Adobe 

wŜŀŘŜǊΩǎ Print window? 

 ..........................................................................................................................................................................  

Learners practise independently. 

8.15 Now practise by printing Matthew chapters 1-5. Follow the Printing a single book 

and Printing part of a book instructions. (But click on Cancel rather than OK at the 

ŜƴŘ ǎƻ ǘƘŀǘ ȅƻǳ ŘƻƴΩǘ ŀŎǘǳŀƭƭȅ ǇǊƛƴǘΦύ 

8.16 How many pages did you need for Matthew chapters 1-5? How did you type it into 

!ŘƻōŜ wŜŀŘŜǊΩǎ Print window? 

 ..........................................................................................................................................................................  

8ɀ4 Saving the PDF file to a flash drive  

8.17 ²Ƙŀǘ ƛŦ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ ŀ ǇǊƛƴǘŜǊ ŀǘǘŀŎƘŜŘ ǘƻ ȅƻǳǊ ŎƻƳǇǳǘŜǊΚ ¸ƻǳ ƴŜŜŘ ǘƻ ǘŀƪŜ ǘƘŜ 

PDF file to another computer that does have a printer attached. 

Tutor demonstrates, learners watch.  

Saving the Print Draf Ôȣ PDF file to a flash drive  

1. Insert a VIRUS-free FLASH DRIVE into a USB PORT on your computer. 

2. Follow the Printing a single book instructions up to step  9, where the PDF 

file opens in Adobe Reader. 

3. Within Adobe Reader, go to the File  menu and click on 3ÁÖÅ !Óȣ 

 



74 last edited 30 June 2011 

4. A SUBMENU will open at the right of the main File  menu. Click on 0$&ȣ on 

that submenu. 

 

5. A window labelled Save As opens up. Where it says Save in:, click on the 

downward-pointing arrow to bring up the list of places that you can save 

your file. 

 

6. Under Computer, click on the name of your flash drive. (Your screen will 

not look exactly the same as this.) 
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7. Now click on the Save button. Your file will save to your flash drive. Now 

you can take it to another computer for printing. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  



76 last edited 30 June 2011 

Module summary  

This module has shown how you can: 

Task Summary of steps Page 

Print a book. 

1. Open (or click in) the project that you want to print 

from, and go to the book that you want to print. 

2. If necessary, do Chapter/Verse Numbers and Markers 

checks. 

3. Go to the File menu and choose tǊƛƴǘ 5ǊŀŦǘΧ  

4. In the Print Draft window, check that the name of your 

project shows next to Project:. 

5. Check that Current Book is selected and shows the 

name of the book you want to print. 

6. In the Layout section, choose a Line Spacing OPTION. 

7. Click on OK. 

8. Wait until Adobe Reader opens and displays your file. 

SCROLL through to check that it contains everything that 

you want to print. 

9. Within Adobe Reader, go to the File menu and choose 

tǊƛƴǘΧ The Print window will open. 

10. In the section labelled Printer, check that you can see 

the name of your printer. 

11. Click on OK to print. 

68 

Print part of a book. 

Follow the instructions above. 

¶ At step 8, SCROLL through the PDF file and decide 

which pages you need to print. 

¶ When the Adobe Reader Print window opens, in the 

section Print Range, select Pages and type the 

numbers of the pages that you want to print: 

¶ consecutive pages, e.g. 1-6; 

¶ non-consecutive pages, e.g. 1, 6, 12-15. 

72 
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Save a tǊƛƴǘ 5ǊŀŦǘΧ 

PDF to a flash drive. 

1. Insert a VIRUS-free FLASH DRIVE into your computer. 

2. Follow the Print a book instructions up to step 8, 

where the PDF file opens in Adobe Reader. 

3. Within Adobe Reader, go to the File menu and click on 

{ŀǾŜ !ǎΧ 

4. From the SUBMENU, click on t5CΧ 

5. A window labelled Save As opens up. Where it says 

Save in:, click on the downward-pointing arrow to bring 

up the list of places that you can save your file. 

6. Click on the name of your flash drive. 

7. Click on the Save button. 

73 
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9. Practice session 3 (simulation)  

Module outline  

In this module you will perform a SIMULATION of working on a Bible translation, using the 

skills you have learnt so far. 

 

9ɀ1 Introduction  

9.1 As you learn new skills, the simulations are becoming more complicated (and 

realistic). This simulation includes Chapter/Verse Numbers and Markers checks, and 

printing. 

9.2 Follow the instructions below to create a mini-translation in Tok Pisin. Remember to 

use the general Outline of procedure instructions below and also the Specific 

instructions  for this simulation. 

9.3 You need to pretend that this work takes place over several weeks or months. That is 

why you need to do Send/Receive and aŀǊƪ tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ several times. 

9.4 If you have forgotten how to perform some skills, refer back to the procedure 

instructions given in the previous modules. Use the Table of Contents at the front of 

this handbook to help you find the procedure you need. Or use the summaries at the 

end of the modules. 

9.5 5ƻƴΩǘ ŦƻǊƎŜǘ ǘƻ ǇǊŀŎǘƛǎŜ ǳǎƛƴƎ ǘƘŜǎŜ ƪŜȅ ŎƻƳōƛƴŀǘƛƻƴǎΥ 

¶ Copy SELECTed text. Ctrl + C 

¶ Paste copied text. Ctrl + V 

¶ DELETE selected text. Backspace or Delete 

¶ Change selected text. Type new wording while text is highlighted. 

¶ Undo a mistake. Ctrl + Z 

Read the Outline of procedure together out loud. 

Tutor explains clearly how to use the Specific instructions. 

As the students work, tutor checks that they are doing each step correctly, and gives help as required. 
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Outline of procedure  

1. Open Paratext. 

2. If necessary, do these things: 

¶ Open your project. 

¶ Open the resources you need. 

¶ Arrange the project and resource windows. 

3. Do Send/Receive  to a flash drive. 

4. Take a -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ ȬÐÈÏÔÏȭ ÁÎÄ ÇÉÖÅ ÉÔ Á ÓÕÉÔÁÂÌÅ ÎÁÍÅȢ 

5. Find the book/chapter/verse point in your project where you need to 

start typing. 

6. Type your translation into your project. 

7. Save your work regularly by pressing Ctrl  + S. 

8. When you finish entering the text, save your work again. Then take 

another -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ photo. 

9. Now check your work carefully for typing errors, and make any 

corrections needed. 

10. Save your work again, then take another Mark Point in Project 

(ÉÓÔÏÒÙȣ photo. 

11. Perform a Chapter/Verse Numbers check. Keep checking until there are 

no more mistakes found. 

12. Perform a Markers check. Keep checking until there are no more 

mistakes found. 

13. Print out your work (the part you have just done). 

14. Perform Send/Receive . 

15. Some time passes and your team has decided on certain changes to the 

passage. Take another -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ photo. 

16. Make the changes. 

17. Save your work. Take another Mark Point in Project Hi ÓÔÏÒÙȣ photo. 

18. Perform Send/Receive . 
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19. Now your team has decided to enter some headings into the translation. 

Take another -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ photo. 

20. Insert the headings. 

21. Save your work. Take another -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ photo. 

22. Then perform Send/Receive . 

23. Close Paratext. 

9ɀ2 Specific instructions  

9.6 For this simulation, use the practice project Tok Pisin simulation project. Choose one 

other resource and open it. Choose the screen layout Stacked 2 Column. 

9.7 ¸ƻǳ ǿƛƭƭ ōŜ ΨǘǊŀƴǎƭŀǘƛƴƎΩ John 1:1-18. This is the text that you need to type (it comes 

from the Tok Pisin Bible 1999): 

1 Bipo bipo tru, tok i stap. Tok i stap wantaim God na tok em yet i God. 

2 Bipo bipo tru tok i stap wantaim God. 

3 Long dispela tok tasol God i mekim kamap olgeta samting. Na i no gat wanpela 

samting i kamap long narapela rot. Nogat. Olgeta samting i kamap, em tok yet i 

mekim kamap. 

4 Laip i stap long em, na dispela laip em i lait bilong ol manmeri. 

5 Dispela lait i save lait i stap long tudak, na tudak i no bin daunim em.  

6 Wanpela man i kamap, nem bilong en Jon. God i bin salim em i kam. 

7 Em i kam bilong autim tok. Em i autim tok bilong dispela lait, bai olgeta manmeri i 

ken harim tok bilong em, na ol i ken bilip. 

8 Em yet em i no dispela lait. Nogat. Em i kam bilong autim tok tasol bilong dispela lait. 

9 Dispela lait em i lait tru na i save givim lait long olgeta manmeri, em i laik i kam long 

graun.  

10 Orait tok em i stap long graun. Long dispela tok tasol God i bin wokim graun, tasol 

ol manmeri bilong graun ol i no luksave long em. 

11 Em i go long as ples bilong em yet, tasol ol lain bilong en ol i no kisim em. 

12 Tasol sampela manmeri i kisim em, em ol lain i bilip long nem bilong em. Na em i 

givim namba long ol bai ol i ken kamap pikinini bilong God. 

13 Ol i no kamap pikinini bilong God long blut bilong papamama, o long laik bilong 

bodi, o long laik bilong man. Nogat. God i mekim ol i kamap pikinini bilong em.  
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14 Tok em i bin kamap man, na em i kam i stap klostu long mipela. Mipela i lukim pinis 

bikpela namba na strong bilong em. Em i namba bilong dispela wanpela Pikinini 

tasol, Papa i salim em i kam. Marimari na pasin i tru i pulap long em. 

15 Jon i tokim ol manmeri long em na i singaut olsem, άEm dispela man, bipo mi tokim 

yupela pinis long em. Mi bin tok olsem, ΨMan i kam bihain long mi, em i namba wan 

bilong mi. Long wanem, em i stap bipo, taim mi no kamap yet.Ω έ 

16 Marimari i pulap moa yet long dispela man, na long marimari bilong em, em i save 

mekim gut tru long yumi olgeta. 

17 I tru, God i givim lo long yumi long han bilong Moses. Tasol long Jisas Krais yumi 

kisim marimari wantaim pasin i tru. 

18 I no gat wanpela man i bin lukim God. Nogat tru. Dispela wanpela Pikinini Bilong 

God, em yet i God na em i stap klostu tru long Papa, em wanpela tasol i bin soim 

God long yumi. 

9.8 When you print out your work (step  13), just print out the section you have 

ΨǘǊŀƴǎƭŀǘŜŘΩ όƛΦŜΦ WƻƘƴ мΥм-18). 

9.9 Changes to make following the team review (step  15): 

¶ v1 ς after Bipo bipo tru, insert the phrase taim olgeta samting i no kamap yet, 

(note the comma at the end). 

¶ in verses 1-3 and verse 10Σ Ǉǳǘ ŀ ŎŀǇƛǘŀƭ Ψ¢Ω ƻƴ tok each time (but not in verses 7-

8). 

¶ v13 ς insert yet after God in God i mekim. 

¶ v14 ς change klostu to namel. 

¶ start new paragraphs at verses 6, 10, 14, 16. 

9.10 Headings to insert (step  19): 

¶ insert book title before the start of chapter 1 (before the /c 1 marker) ς 

\mt Gutnius Jon i raitim (note the marker). 

¶ insert section heading before v1 - Tok i gat laip em i kamap man. 

9ɀ3 Debrief  

Class discussion. 

9.11 After everybody has completed the simulation, discuss what was easy and what was 

hard. What could you do without looking at the procedure instructions? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  
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 ..........................................................................................................................................................................  

9.12 What procedures did you need the instructions for? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

9.13 Did you understand why you needed to do certain procedures at certain stages of the 

ǇǊƻŎŜǎǎ όŜΦƎΦ ǘŀƪƛƴƎ ŀ ΨǇƘƻǘƻΩ ƻŦ ǘƘŜ ǇǊƻƧŜŎǘΣ ŘƻƛƴƎ a Markers check)? Were there any 

ǎǘŜǇǎ ǘƘŀǘ ȅƻǳ ŘƛŘƴΩǘ ǎŜŜ ǘƘŜ ǇǳǊǇƻǎŜ ƻŦΚ 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

9.14 Is there anything you would like the tutor to review with you at this point? If so, 

please let the tutor know (you can write it on a piece of paper if you like). 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  
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10. Using Paratext as a team 

(backing up and sharing your project)  

Module outline  

In this module, you will learn how to: 

¶ decide on a Send/Receive routine for your team; 

¶ avoid editing conflicts within a project; 

¶ make your changes undo-able; 

¶ edit a back translation. 

 

Note: Before trying to use Send/Receive with more than one computer, you need to have a 

computer specialist help you set up Send/Receive ƻƴ ȅƻǳǊ ǘŜŀƳΩǎ ŎƻƳǇǳǘŜǊǎΦ Send/Receive 

must be started properly. A specialist can read the instructions for setting up Send/Receive 

in the UBS document Paratext7.1ProjectSharingManual.pdf.  

Do not try to use send/receive to share data with your team members until a specialist has 

done this. 

10ɀ1 Motivation (drama)  

Two tutors act out the drama. 

Person #1: Oh, no! Our project is in a terrible mess! All of us have made changes and 

ƴƻǿ ǿŜ ŎŀƴΩǘ ǘŜƭƭ ǿƘŀǘ ƛǎ ǊƛƎƘǘ ŀƴŘ ǿƘŀǘ ƛǎ ǿǊƻƴƎΦ 

Person #2: Did you discuss the changes first as a team? 

Person #1: No! 

Person #2: Did you keep to the rule about two people never working on the same 

chapter at the same time? 

Person #1: No! 

Person #2: Did you remember to take a photo? 

Person #1: No! 

Person #2: Did you do a print-out? 

Person #1: No! 

Person #2: Did you remember to do Send/Receive? 
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Person #1: Yes! 

Person #2: Thank God! You did the right thing, and the clever people who wrote the 

Paratext program have made it possible for us to go back to an earlier version 

of the project. 

10.1 In this module we will be discussing how to use Paratext together as a team. We 

ǿƻƴΩǘ ōŜ ƭŜŀǊƴƛƴƎ Ƴŀƴȅ ƴŜǿ ǎƪƛƭƭǎΣ ōǳǘ ǿŜ ǿƛƭƭ ōŜ ǘŀƭƪƛƴƎ ŀōƻǳǘ ǎƻƳŜ ƎƻƻŘ ƛŘŜŀǎ ŀƴŘ 

suggestions for using Paratext as effectively as possible. 

10.2 If you are an experienced user, you will probably have some suggestions of your own 

that you can share with us. 

10ɀ2 Project sharing  with Send/Receive  

10.3 The Send/Receive FUNCTION ŘƻŜǎƴΩǘ Ƨǳǎǘ ƭŜǘ ȅƻǳ BACKUP your project efficiently. It also 

allows you to share your work with other team members who are working on 

different computers. 

10.4 Suppose that you are making the first draft of one Bible book, and your team-mate is 

translating another book. Later she will check your work, and you will check hers. You 

need to exchange your work so that you both have the most up-to-date version of 

both books. Send/Receive lets you do this. 

10.5 To ensure that all changes are exchanged between two users, Send/Receive has to 

be done three times. 

10.6 Practise doing this by passing a flash drive around. 

Learners practise in pairs. Tutor supervises and assists. 

Sharing project changes between two computers  

1. When you and your team-mate would like to share your changes, both of 

you need to stop working. 

2. Team member 1 does steps  3- 6: 

3. Insert the FLASH DRIVE. 

4. On the BUTTON BAR, click the Send/Receive  ( ) button. 

5. Wait until the green progress meters have gone away. The flash drive 

will now contain the latest copy of your changes. 

6. Safely eject the flash drive. 
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7. Team member 2 takes the flash drive and does steps  3- 6 on their 

computer. .Ï× ÔÈÅÙ ÈÁÖÅ ÍÅÍÂÅÒ ρȭÓ ÃÈÁÎÇÅÓ ÏÎ ÔÈÅÉÒ ÃÏÍÐÕÔÅÒȟ ÂÕÔ 

they have to share their own changes with member 1. 

8. Team member 1 takes the flash drive and does steps  3- 6 again. Now he/she 

ÈÁÓ ÔÅÁÍ ÍÅÍÂÅÒ ςȭÓ ÃÈÁÎÇÅÓȟ ÁÎÄ ÂÏÔÈ ÏÆ ÙÏÕ ÈÁÖÅ ÕÐ-to-date projects. 

10.7 Remember: if you have two team members, you need to have member 1 do a 

Send/Receive, then member 2, then member 1 again. 

10.8 If three or more people need to share their changes, the routine is a bit different. 

Learners practise in groups of 3-4. Tutor supervises and assists. 

Sharing project changes between 3+ computers  

1. Everybody stops working. 

2. Team member 1 does Send/Receive  to a FLASH DRIVE, then safely ejects 

the flash drive. 

3. Team member 2 does Send/Receive  to a flash drive, then safely ejects 

the flash drive. 

4. Each other team member in turn does Send/Receive  to a flash drive, 

then safely ejects the flash drive. 

5. Team member 1 takes the flash drive and does another Send/Receive , 

then safely ejects the flash drive. 

6. Team member 2 takes the flash drive and does another Send/Receive , 

then safely ejects the flash drive. 

7. Each other team member in turn takes the flash drive and does another 

Send/Receive , then safely ejects the flash drive. 

8. Once everybody has done Send/Receive  twice, every computer has the 

most up-to-date version of the project. 

10.9 So if your team uses more than two computers, everybody needs to do 

Send/Receive twice in order to share all the changes. 

10ɀ3 Avoiding editing conflicts  

Class discussion, tutor writes responses on board. Some suggested answers are in the Appendix. 
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10.10 A conflict happens when two or more people edit the same verse before doing the 

ǘŜŀƳΩǎ Send/Receive routine. When this happens, the edits that one of them made 

will be in the translation, and Paratext will save the other set of changes so 

somebody can decide later which ones should stay in the translation. This is extra 

ǿƻǊƪ ǘƘŀǘ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ ǘƻ ŘƻΣ ǎƻ ǘƘŜ ōŜǎǘ ǘƘƛƴƎ ƛǎ ǘƻ ŀǾƻƛŘ ŎƻƴŦƭƛcts. 

10.11 5ƻƴΩǘ ever have two people working on the same chapter! 

10.12 If one person is doing a GLOBAL function (one that crosses over chapters), everybody 

else stops working until they have completed it. 

Team procedure for global functions  

1. Everybody stops working. 

2. %ÖÅÒÙÂÏÄÙ ÓÈÁÒÅÓ ÔÈÅÉÒ ÃÈÁÎÇÅÓ ÕÓÉÎÇ ÔÈÅ ÔÅÁÍȭÓ Send/Receive  routine. 

3. One team member performs the GLOBAL FUNCTION. 

4. Everybody does Send/Receive  again to receive the changes made by the 

global function. 

5. Everybody starts working again. 

10.13 What are some exampleǎ ƻŦ ΨƎƭƻōŀƭΩ functions? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

10ɀ4 Make your project undo -able 

10.14 Take Mark Point in Project History photos often. These make it possible to un-do big 

problems and mistakes. 

10ɀ5 Doing a back translation  

Class discussion, tutor writes responses on board. 

10.15 Now we will think about how you can include your BACK TRANSLATION in Paratext. 

10.16 It is very wise to be working on your back translation at the same time as you do your 

vernacular (tokples) front-translation. 

10.17 What are some reasons for working on your back translation at the same time as 

doing your translation? 
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 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

10.18 Your back translation will be a Paratext project just like your translation project. If 

ȅƻǳ ŘƻƴΩǘ ŀƭǊŜŀŘȅ ƘŀǾŜ ƻƴŜΣ ƴƻǿ Ƴŀȅ ōŜ ŀ ƎƻƻŘ ǘƛƳŜ ǘƻ ƘŀǾŜ ŀ ŎƻƳǇǳǘŜǊ ŜȄǇŜǊǘ 

create that project for you in Paratext. 

10.19 All the lessons you have learned for working on your translation in Paratext will help 

you when working on your back translation. 

10.20 A future version of Paratext will help us remember to keep our back translation up-

to-date with our translation. 

10ɀ6 Sharing ideas 

Class discussion, tutor writes suggestions on board. 

10.21 Now is the time to share your ideas with everybody else. Has your team developed 

some routines to make sure you use Paratext well together? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

10ɀ7 Summary of the rules for working together using Paratex t 

¶ Backup your project often using Send/Receive. 

¶ Share changes often between team members using your Send/Receive routine.  

¶ Never let two people work on the same chapter at the same time.  

¶ When global changes are being made with Basic Checks, Spell Checking or other 

tools, only one team member can be working on the project.  

¶ Make Mark Point in Project History photos often. 

¶ Keep your back translation up-to-date.  

ω  .......................................................................................................................................................  

ω  .......................................................................................................................................................  
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Module summary  

This module has shown how you can: 

Task Summary of steps Page 

Share project changes 

between two 

computers. 

1. Both team members stop working. 

2. Team member 1 does the following: 

a) Insert the FLASH DRIVE. 

b) Click the Send/Receive button on the button bar. 

c) When the green progress meters have gone away, 

safely eject the flash drive. 

3. Team member 2 does step 2. 

4. Team member 1 does step 2 again. Now both team 

members have up-to-date projects. 

84 

Share project changes 

between 3+ 

computers. 

1. Everybody stops working. 

2. Team member 1 does Send/Receive to a FLASH DRIVE, 

then safely ejects the flash drive. 

3. Each other team member in turn does Send/Receive to 

a flash drive, then safely ejects the flash drive. 

4. Team member 1 takes the flash drive and does another 

Send/Receive, then safely ejects the flash drive. 

5. Each other team member in turn takes the flash drive 

and does another Send/Receive, then safely ejects the 

flash drive. 

6. Once everybody has done Send/Receive twice, every 

computer has the most up-to-date version of the 

project. 

85 
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11. Project Notes 

Module outline  

In this module, you will learn how to: 

¶ insert a Project Note; 

¶ change or delete a Note; 

¶ add another Note to an existing one; 

¶ mark a Note as Reviewed or Resolved; 

¶ view a list of Notes. 

 

11ɀ1 Motivation (drama & discussi on)  

Two tutors act out the drama. 

Person #1: Today we need to discuss the notes that we took during village checking. 

(turns to Person 2) Did you bring the paper that we wrote them on? 

Person #2: !ƘΧƴƻΦ aȅ ǎƻƴ ǘǳǊƴŜŘ ǘƘŜ ǇƛŜŎŜ ƻŦ ǇŀǇŜǊ ƛƴǘƻ ŀƴ ŀŜǊƻǇƭŀƴŜ ŀƴd threw it into 

the river. (throws paper plane towards students) 

Class discussion, tutor writes answers on board. 

11.1 What kinds of notes do you need to write about your project? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

11.2 Who reads the notes? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

11.3 At the moment, how do you record your notes, and how do you store them? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  
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11ɀ2 What is a Project Note? 

11.4 Paratext has a built-in notes FUNCTION. PROJECT NOTES are part of your project, but they 

are not part of the Bible text at all όŘƻƴΩǘ ŎƻƴŦǳǎŜ ǘƘŜƳ ǿƛǘƘ FOOTNOTES or study 

notes). They are just a helping tool for translators, advisers, consultants and other 

ǇŜƻǇƭŜ ǿƻǊƪƛƴƎ ƻƴ ǘƘŜ ǘǊŀƴǎƭŀǘƛƻƴ ǇǊƻƧŜŎǘΦ ¸ƻǳ ǿƻƴΩǘ ǎŜŜ ȅƻǳǊ tǊƻƧŜŎǘ bƻǘŜǎ ǿƘŜƴ 

you print out the text of your translation, but you can print them separately. 

11.5 Because the Project Notes are part of the project, they get saved whenever the 

project does. And when you do Send/Receive, the Notes get shared around, just as 

the text does. This is a convenient way to share information between team members, 

and an easy way for a consultant or adviser to make suggestions on how you can 

improve your translation. 

11ɀ3 Insert ing a Project Note 

11.6 Start by opening the English Practice Project. 

11.7 Go to John 1:29. Insert a Note about the word Sheep that reads Is this the best word 

to use? 

Tutor demonstrates, learners watch.  

Inser ting a Project Note  

1. Insert the cursor inside the text that you want to 

make a Note about. There are three OPTIONS for 

doing this: 

¶ click inside a word; 

¶ SELECT some text; 

¶ click inside the verse number of the verse you 

want to make a Note about. 
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2. Go to the Insert  menu and choose .ÏÔÅȣ 

 

3. Type in the text of your Note. 

 

4. Click on OK. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  

Learners practise independently. 

11.8 Notice the red flag that is now in the text, showing where the Note is. The red colour 

tells you that the STATUS ƻŦ ǘƘŜ bƻǘŜ ƛǎ ά¢ƻ 5ƻέ ς somebody needs to read the Note 

and do something about what it says. 
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11.9 Now make a Note about the word Christ in verse 41 (HIGHLIGHT the word before you 

insert the Note). The Note should read Should we translate the word instead of using 

the Greek word? 

11.10 Now insert a Note about verse 51 (click inside the verse number first). The Note 

should read We probably need a footnote here. 

11.11 Now make a Note about the words fig tree in verse 50 (SELECT the words before you 

insert the Note). You want the Note to say that it would be good to have a picture 

here. Write your own wording for the Note. 

11.12 Enter two more Notes of your own.  

11ɀ4 Viewing  and changing Notes 

Class activity.  

11.13 Look at the window containing 

your project. How do you 

know where the Notes are? 

 ..........................................................................................................................................................................  

11.14 Notice that the word/words you attached the Note to are underlined. 

11.15 Move the CURSOR over the Note flag 

ICON at verse 51. What does the cursor 

turn into? 

 ..........................................................................................................................................................................  

11.16 What else do you see? 

 ..........................................................................................................................................................................  

11.17 Click on a Note flag. What 

do you see now? 

 ..........................................................................................................................................................................  
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Tutor writes answers on board, adds any that students may miss. Answers are in the Appendix. 

11.18 What useful information do you see in this window? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

11.19 Paratext thinks you might want to type a new Note under the first one, so it has 

created a new Note box for you. But instead, you want to change the original Note 

that you wrote. 

11.20 Notice there are two little BUTTONS at the top right of the original 

Note that you wrote. Click 

on the one that looks like a 

paper and pencil. 

11.21 Paratext automatically 

highlights all the text of the 

Note that you typed before. If you just start typing straightaway, what will happen? 

Try it and see! 

 ..........................................................................................................................................................................  

11.22 Change the Note to read Do we need a footnote explaining what this refers to? 

11.23 Click on OK. 

11.24 bƻǿ ȅƻǳ ŘŜŎƛŘŜ ǘƘŀǘ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ ŀ bƻǘŜ ƘŜǊŜ ŀǘ ŀƭƭΦ /ƭƛŎƪ ƻƴ ǘƘŜ ŦƭŀƎ ŀƎŀƛƴΦ 

11.25 Now click on the red cross BUTTON next to the first Note.  

11.26 What is the message that comes up on the screen? 

 ..........................................................................................................................................................................  

11.27 Yes, you really do want to delete this Note. Click on Yes. Confirm that the Note flag 

has disappeared from verse 51. 

11.28 Go to the Note at verse 41 and click on the flag. 

11.29 Once again, Paratext provides you with a box to type a second Note into. Type in It 

ƳŜŀƴǎ ά!ƴƻƛƴǘŜŘ hƴŜέ. Then click OK. 

11.30 Now hold the cursor over the flag again. What is different now? 

 ..........................................................................................................................................................................  

11.31 /ƭƛŎƪ ƻƴ ǘƘŜ bƻǘŜ ŦƭŀƎ ŀƎŀƛƴΦ bƻǘƛŎŜ ǘƘŀǘ ƴƻǿ ȅƻǳǊ ƻǊƛƎƛƴŀƭ bƻǘŜ ŘƻŜǎƴΩǘ ƘŀǾŜ the 

little buttons at the top right ŀƴȅ ƳƻǊŜΦ ¸ƻǳ ŎŀƴΩǘ ŎƘŀƴƎŜ ƻǊ ŘŜƭŜǘŜ it now. But you 

can change or delete your second Note (or add a third one!). 
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11.32 Go to Revelation 1:4. There is a Note here. Who made the Note? 

 ..........................................................................................................................................................................  

11.33 Try to delete the Note. Can you do it? 

 ..........................................................................................................................................................................  

11ɀ5 Reviewing and Resolving a Note  

11.34 wŜƳŜƳōŜǊ ǘƘŀǘ ŀ ǊŜŘ ŦƭŀƎ ƳŜŀƴǎ ά¢ƻ 5ƻέ ς the Note is telling you about a problem 

that needs fixing. Your team will eventually come back to all the difficult verses and 

find a solution to the problems in the Notes. Now you need to indicate in each Note 

that the problem has been solved. 

11.35 There are two stages to doing this. You can mark a Note as Reviewed to indicate that 

the problem has been seen and discussed. Then when it has been completely dealt 

with, you can mark the Note as Resolved. 

11.36 This two-stage process makes good sense if the person making the original Note is 

not the person responsible for finding a solution to the problem. For example, an 

advisor or consultant may make a Note that a particular verse has an exegetical 

problem. Then it is the translation teamΩǎ Ƨƻō ǘƻ come up with a revised translation. 

So the sequence of steps is: 

¶ the advisor/consultant makes a Note to point out a problem; 

¶ the translation team discuss the problem and come up with a solution ς they 

add a second Note explaining the solution and mark the Note as Reviewed; 
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¶ ǘƘŜ ŀŘǾƛǎƻǊκŎƻƴǎǳƭǘŀƴǘ ŎƘŜŎƪǎ ǘƘŜ ǘǊŀƴǎƭŀǘƛƻƴ ǘŜŀƳΩǎ ǎƻƭǳǘƛƻƴ and marks the 

Note as Resolved if he approves the solution. If not, he may write a new Note 

ŀƴŘ Ǉǳǘ ǘƘŜ bƻǘŜΩǎ STATUS ōŀŎƪ ǘƻ ΨǊŜŘ ŦƭŀƎΩ ŀƎŀƛƴ ǎƻ ǘƘŜ ǘŜŀƳ ƪƴƻǿǎ ǘƘŜȅ ŀǊŜ ƴƻǘ 

done with this problem. 

11.37 To practise this process, go back to John 1. We will start with the Note in verse 29, 

changing its status to Reviewed and adding a second Note that We have decided to 

use the ǿƻǊŘ Ψ[ŀƳōΩ ƛƴǎǘŜŀŘΦ 

Tutor demonstrates, learners watch. Then the tutor undoes the changes to the Note to be able to 

demonstrate again.  

Marking a Note as Reviewed  

1. Click on the flag ICON for the Note.  This brings up the Note window. 

2. Type a new Note explaining what has been done about the problem in 

the original Note. 

3. At the top left of the Note window are two BUTTONS, one with a red flag 

and one with a grey flag. The red flag button currently has a blue box 

around it. 

 

4. Click on the grey flag BUTTON. The blue box moves from 

the red flag to the grey flag. 

5. If you are happy with the wording of the Note, click on OK. 
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Tutor demonstrates, learners perform each step of demonstration after the tutor.  

11.38 What does the flag ICON in the text look like now?  

 ..........................................................................................................................................................................  

Learners practise independently. 

11.39 Open the Note at verse 41. Hold the CURSOR over the grey flag button at the top left 

of the window. What writing comes up to tell you the FUNCTION of the button? 

 ..........................................................................................................................................................................  

11.40 Now change the NoteΩǎ STATUS to Reviewed. The new Note should read We decided to 

ǎǘŀȅ ǿƛǘƘ Ψ/ƘǊƛǎǘΩΦ 

11.41 Now change one of your other Notes to Reviewed. Make sure you add a second Note 

to explain how you solved the problem. 

11.42 Now suppose that everybody is happy with the solutions to the problems, and we 

can mark the Notes as Resolved. Go back to the Note at John 1:29. 

Tutor demonstrates, learners perform each step of demonstration after the tutor. όLǘ ƛǎƴΩǘ 

straightforward ǘƻ ǊŜǾŜǊǘ ǘƘƛǎ ŎƘŀƴƎŜΣ ǎƻ ŘƻƴΩǘ Řƻ ŀ ǎŜǇŀǊŀǘŜ ƛƴƛǘƛŀƭ ŘŜƳƻƴǎǘǊŀǘƛƻƴΦύ 

Marking a Note as 

Resolved 

1. #ÌÉÃË ÏÎ ÔÈÅ .ÏÔÅȭÓ 

flag ICON to open the 

Note window. 

2. You can add another 

Note if you like. 

3. Then click on the 

Resolve Note button. 

 

11.43 What has happened to the flag icon in the text?  

 ..........................................................................................................................................................................  

11.44 ¸ƻǳ ŎŀƴΩǘ ǎŜŜ ǘƘŜ ŦƭŀƎ ŀƴȅ ƳƻǊŜΣ ōǳǘ ǘƘŜ bƻǘŜ ƛǎ ǎǘƛƭƭ ǘƘŜǊŜΦ Lǘ ƘŀǎƴΩt been deleted, and 

there is still a way to view it. 

Learners practise independently. 
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11.45 Mark the other Notes in John 1 as Resolved. 

11ɀ6 Viewing a list of Notes 

11.46 You may find it useful to view several Notes at once, to check which ones have been 

Reviewed or Resolved and which ones still need to be dealt with. This is especially 

helpful when you only have a few Notes left to work on in a big book, and scrolling to 

find them would take a long time. 

11.47 Before you start this exercise, set your windows layout to Stacked 2 Column. 

Tutor demonstrates, learners watch.  

Viewing a list of Project Notes  

1. If necessary, open your project and go to the book/chapter/verse  you 

want to see the Notes for. 

2. Go to the File  menu and 

choose /ÐÅÎ .ÏÔÅÓȣ 

 

3. A window comes up with a list of projects. If you were already working in 

your project or opened it at step  1, the name of it will be highlighted. If 

not, SELECT the project you want. 
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4. Click on OK. A window opens up with a list of Notes. 

 

5. At the top there are two lists that let you restrict the number of Notes 

you see. 

 

¶ The first list  lets you choose All books, Current Book, Current Chapter 

or Current Verse, by clicking on the downward-pointing arrow. 

 

¶ The second list  lets you choose Notes by STATUS (e.g. Unread, To-Do, 

Reviewed or Resolved), by clicking on the downward-pointing arrow. 
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6. The third list  lets you list the Notes by verse or by the date that the Note 

was written (the most recent Note is at the top). 

 

7. This window only shows the first Note in each sequence. To see all the 

Notes attached to a particular flag, click on Edit  for that Note sequence. 

This will open up the Note window. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  

11.48 [ƻƻƪ ŀǘ ǘƘŜ ƭƛǎǘ ƻŦ bƻǘŜǎ ŦƻǊ WƻƘƴΩǎ DƻǎǇŜƭ ƛƴ ǘƘŜ English Practice Project (select 

Current Book from the first list). Confirm that your Resolved Notes are still there. 

Class discussion, tutor writes responses on board. 

11.49 What information can you see about each Note? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

11.50 Go to Revelation 1 in the project window. What happens in the Notes list? 

 ..........................................................................................................................................................................  

11.51  Mark one of these Notes as Reviewed. How does it change in the Notes list? 

 ..........................................................................................................................................................................  
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11.52 Mark a Note as Resolved. Is it still listed in the Notes list? What has changed? 

 ..........................................................................................................................................................................  

11.53 Try out the different buttons that let you restrict the number of Notes you see. 

11.54 If you are wondering about the box with a magnifying glass next to it, ǘƘŀǘΩǎ ǘƘŜ 

SEARCH BOX. You can type some text here to find a lost Note! 

 

11.55 Set the middle buttons to say All books and All. 

11.56 Now type lamb into the search box. Watch what happens to the list of Notes as you 

type. (If you coǳƭŘƴΩǘ ǎŜŜ ǿƘŀǘ ƘŀǇǇŜƴŜŘΣ ŘŜƭŜǘŜ ǘƘŜ ǿƻǊŘ ŦǊƻƳ ǘƘŜ ǎŜŀǊŎƘ ōƻȄ ŀƴŘ 

type it again.) 

11.57 Click on the Edit button for the Note to confirm that it does in fact contain the word 

lamb. Did this find capitalised words too? 

11.58 When you have finished practising, close the Notes list window. 

11ɀ7 Tips for using Notes  

Class reads these together. 

11.59 Be careful what you write! You may not be able to change your NƻǘŜ ŀŦǘŜǊ ȅƻǳΩǾŜ 

written it. LŦ ȅƻǳΩǊŜ ƳŀƪƛƴƎ ŀ ŎƻƳƳŜƴǘ ŀōƻǳǘ ǎƻƳŜōƻŘȅ ŜƭǎŜΩǎ ǿƻǊƪΣ ōŜ ǇƻƭƛǘŜΗ 

11.60 ¸ƻǳ ŎŀƴΩǘ ŎƘŀƴƎŜ ƻǊ ŘŜƭŜǘŜ ƻǘƘŜǊ ǇŜƻǇƭŜΩǎ bƻǘŜǎΦ ¸ƻǳ ǿƛƭƭ ōŜŎƻƳŜ ŦŀƳƛƭƛŀǊ ǿƛǘƘ ǘƘƛǎ 

when you share your project with other team members using Send/Receive. 

11.61 You can only change or delete your own Note if it is the last one in the list. 

11.62 Just because you can ŘŜƭŜǘŜ ŀ bƻǘŜ ŘƻŜǎƴΩǘ ƳŜŀƴ ȅou should! Only delete a Note if 

ȅƻǳΩǊŜ ǊŜŀƭƭȅ ǎǳǊŜ ǘƘŀǘ ȅƻǳ ŘƻƴΩǘ ǿŀƴǘ ƛǘ ǘƘŜǊŜΦ 5ƻƴΩǘ ŘŜƭŜǘŜ ƛǘ Ƨǳǎǘ ōŜŎŀǳǎŜ ȅƻǳǊ ǘŜŀƳ 

has resolved the issue in the Note ς mark it as Resolved instead. 

11.63 Looking at the list of Project Notes can be very useful when you only have a few 

notes for a whole book and scrolling to find the flags would take a long time. 

11.64 If you are a translator, when looking at the list of Project Notes, you may want to just 

list the Notes that are marked with the status ToDo (the red flag). 

11.65 If you are a consultant or adviser, you may want to just list the notes with either the 

status of ToDo and Reviewed. 
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11.66 If you want the consultant to read a Note, put it in the BACK TRANSLATION project. Make 

sure that Notes for the consultant are in English or Tok Pisin. 

11ɀ8 Review 

11.67 Watch the video Paratext7ProjectNotes.mp4 or .html (except for the final section, 

on printing a Notes Report ς instructions for this can be found in the Appendix). 
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Module summary  

This module has shown how you can:  

Task Summary of steps Page 

Insert a Project Note. 

1. Highlight the text that you want to make a Note about. 

2. Go to the Insert menu and choose bƻǘŜΧ 

3. Type in the text of your Note, then click on OK. 

91 

Change an existing 

Note. 

1. Click on the flag ICON for the Note. 

2. In the Note window, click on the Change 

BUTTON for the Note. 

3. Change the text, then click on OK. 

92 

Delete an existing 

Note 

1. Click on the flag ICON for the Note. 

2. In the Note window, click on the Delete BUTTON 

for the Note. 

3. Click on Yes in the message box, then click on OK in the 

main Note window. 

93 

Add a second Note to 

an existing one. 

1. Click on the flag ICON for the Note. 

2. Type the new Note into the blank Note box. 

3. Click on OK. 

93 

Mark a Note as 

Reviewed. 

1. Click on the flag icon for the Note. 

2. Type a new Note explaining the change of status. 

3. Click on the grey flag BUTTON. 

4. Click on OK. 

95 

Mark a Note as 

Resolved. 

As for marking a Note as Reviewed, but click on the 

Resolve Note button. 
96 
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View a list of Notes. 

1. Open your project and go to the book/chapter/verse 

you want to see the Notes for. 

2. Go to the File menu and choose hǇŜƴ bƻǘŜǎΧ 

3. A window comes up with a list of projects. SELECT the 

project you want, then click on OK. 

4. A window opens up with a list of Notes. 

¶ Type some text into the SEARCH BOX to find Notes 

containing that text. 

¶ The first BUTTON lets you choose All books, Current 

Book, Current Chapter or Current Verse. 

¶ The second button lets you choose Notes by 

STATUS. 

¶ The third button lets you list the Notes by verse or 

by the date that the Note was written. 

5. To see all the Notes attached to a particular flag, click 

on Edit for that Note sequence. 

97 
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12. Practice session 4 (real work)  

Module outline  

In this practice session you will transfer the skills you have learnt so far to working on your 

own translation project. 

 

12ɀ1 Plannin g your practice session  

Class reads through instructions out loud together. 

12.1 This is your first opportunity to use your new knowledge of Paratext on your own 

translation project. So you will be working more independently at this point. You (or 

your team) need to decide what work needs to be done on your project. That should 

ƛƴŎƭǳŘŜ ǎƻƳŜ ƻŦ ǘƘŜ ƴŜǿ ǎƪƛƭƭǎ ǘƘŀǘ ȅƻǳΩǾŜ ƭŜŀǊƴǘ ƛƴ ǘƘŜ ƭŀǎǘ мм ƳƻŘǳƭŜǎ.  

12.2 The tutors are here to help you, so this is a good opportunity to try out something 

ȅƻǳΩǊŜ ƴƻǘ ǎǳǊŜ ŀōƻǳǘΦ !ǎƪ ŀ tutor to come over and help you through the difficult 

skill until you can perform it by yourself. 

12.3 Some suggested skills to practise: 

¶ use Send/Receive to BACKUP your translation project and BACK TRANSLATION 

project to a flash drive (make sure a specialist has set up Send/Receive on your 

ǘŜŀƳΩǎ ŎƻƳǇǳǘŜǊǎ ŦƛǊǎǘΣ ŦƻƭƭƻǿƛƴƎ ǘƘŜ ƛƴǎǘǊǳŎǘƛƻƴǎ ƛƴ ǘƘŜ ¦.{ ŘƻŎǳƳŜƴǘ 

Paratext7.1ProjectSharingManual.pdf); 

¶ use Send/Receive to share your project between team members; 

¶ take aŀǊƪ tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ ΨǇƘƻǘƻǎΩΤ 

¶ review your translation or back translation and make changes using keyboard 

shortcuts; 

¶ run a Chapter/Verse Numbers check and fix any mistakes; 

¶ run a Markers check and fix any mistakes; 

¶ print a book or part of a book; 

¶ insert some Notes into your project or your back translation project. 

12.4 Other things you could do: 

¶ look through the list of resources and decide which ones you will use regularly in 

your project; 

¶ decide how to work on your back translation; 

¶ make some team rules for using Paratext. 
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12.5 There is no fixed procedure to follow in this practice session because everybody will 

ōŜ ŘƻƛƴƎ ŘƛŦŦŜǊŜƴǘ ǘƘƛƴƎǎΦ .ǳǘΧ 

If any of your activities involve actual changes to your translation project or 

back translation project: 

¶ Do a Send/Receive  backup at the start and end of the session! 

¶ Take a -ÁÒË 0ÏÉÎÔ ÉÎ 0ÒÏÊÅÃÔ (ÉÓÔÏÒÙȣ ȬÐÈÏÔÏȭ ÂÅÆÏÒÅ ÁÎÄ ÁÆÔÅÒ 

making changes! 

¶ Save your changes frequently using Ctrl  + S! 

12.6 Now spend some time thinking about (or discussing) what work you want to do on 

your project during this practice session. Thƛǎ ƛǎ ƻƴƭȅ ŀ ǎƘƻǊǘ ǎŜǎǎƛƻƴΣ ǎƻ ŘƻƴΩǘ ǘǊȅ ǘƻ 

do too much. You will have other opportunities to practise later. 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

12ɀ2 Action  

As the students work, tutor gives appropriate help. 

12.7 Work on the activities you chose to do, until the tutor tells you it is time to stop. 

12ɀ3 Debrief  

Class discussion. 

12.8 Discuss the kinds of activities that you chose to do. aŀƪŜ ŀ ƴƻǘŜ ƻŦ ƻǘƘŜǊ ǇŜƻǇƭŜΩǎ 

ideas. You might like to try them in the next practice session. 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  



106 last edited 30 June 2011 

12.9 Which skills were easy to use on your own project? 

 ..........................................................................................................................................................................  

12.10 Which skills needed some thinking before you could use them on your own project? 

 ..........................................................................................................................................................................  

12.11 Which skills did you still need the instructions for? 

 ..........................................................................................................................................................................  

12.12 Did you remember to do Send/Receive at the start and end of the session? 

12.13 Did you remember to use aŀǊƪ tƻƛƴǘ ƛƴ tǊƻƧŜŎǘ IƛǎǘƻǊȅΧ before and after making 

any changes? 

12.14 Did you remember to save regularly as you worked? 

12ɀ4 Self-evaluation  

12.15 At this point in the course you should stop to check that you have understood 

everything we have covered so far. Please complete the following skills list. 

¶ TICK ǘƘŜ άYesέ ŎƻƭǳƳƴ ƛŦ ȅƻǳ Ŏŀƴ ŎƻƳǇƭŜǘŜ ǘƘƛǎ ǘŀǎƪ ǿƛǘƘƻǳǘ ŜǾŜƴ ƭƻƻƪƛƴƎ ŀǘ ǘƘŜ 

instructions. 

¶ ¢ƛŎƪ ǘƘŜ άLƴǎǘǊǳŎǘƛƻƴǎέ column if you can complete the task by following the 

instructions. 

¶ ¢ƛŎƪ ǘƘŜ άbƻέ column if you can only complete this task with someonŜΩǎ ƘŜƭǇ.  

Skill Yes Instructions No 

Open and close Paratext.    

Open a project or resource (in a new window).    

Change the resource that a window is displaying.    

Arrange windows into three columns.    

Move a window.    

Change the size of a window.    

Find a specific book/chapter/verse in a resource.    

SELECT text.    

DELETE selected text.    

Copy selected text.    

Paste copied text.    
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Skill Yes Instructions No 

Undo a mistake you just made.    

Save your work quickly.    

Recognise a USFM MARKER.    

Start a new paragraph in your text (by inserting a 

paragraph marker). 
   

Insert a section heading.    

Insert a verse marker.    

¢ŀƪŜ ŀ ΨǇƘƻǘƻΩ ƻŦ ȅƻǳǊ ǇǊƻƧŜŎǘΦ    

Backup your project onto a FLASH DRIVE (Send/Receive).    

Share project changes between two computers.    

Share project changes between 3+ computers.    

Check your project for missing chapters or verses.    

Check your project for incorrect markers.    

Print the text of a book.    

Print part of a book.    

Save a tǊƛƴǘ 5ǊŀŦǘΧ PDF to a flash drive.    

Insert a Project Note.    

Change or delete an existing Note.    

Add another Note to an existing one.    

Mark a Note as Reviewed or Resolved.    

View a list of Notes.    

 

12.16 Is there anything you would like the tutor to review with you at this point? 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

Tutor passes around pieces of paper. 

12.17 Please write down the topics that you would like to review now. 

Tutor collects papers. 
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13. More on screen layout 

Module outline  

In this module, you will learn how to: 

¶ create a Text Combination (layout of windows); 

¶ create and open a Text Collection (several resources in one window); 

¶ view text as continuous from chapter to chapter; 

¶ change how your text displays markers. 

 

13ɀ1 Review: arranging windows  

Class discussion. 

13.1 In this module we will be looking at some other options for arranging windows on 

the screen in Paratext. .ǳǘ ŦƛǊǎǘΣ ƭŜǘΩǎ ǊŜǾƛŜǿ ǿƘŀǘ ǿŜ ƭŜŀǊƴǘ ōŀŎƪ ƛƴ ƳƻŘǳƭŜ нΦ If 

ȅƻǳΩǊŜ ƴƻǘ ǎǳǊŜ ƻŦ ǘƘŜ ŀƴǎǿŜǊǎΣ ǘǊȅ ƛǘ ƻǳǘ ƛƴ tŀǊŀǘŜȄǘΗ 

13.2 What FUNCTION do you use to arrange your windows in two (or three) neat columns? 

 ..........................................................................................................................................................................  

13.3 What happens when you open another window? 

 ..........................................................................................................................................................................  

13.4 Can you change the size or position of a window when you choose this layout? 

 ..........................................................................................................................................................................  

13.5 But what happens when you close Paratext and open it again? 

 ..........................................................................................................................................................................  

13.6 What function do you use to arrange your windows any way you like, and have them 

stay that way? 

 ..........................................................................................................................................................................  

13ɀ2 Saving combinations  of windows  

Class discussion, tutor writes responses on board. 

13.7 You may like to use different screen layouts for different tasks. What are some 

examples of different tasks that need different arrangements of windows? 
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 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

13.8 It would be annoying to have to open or close windows, rearrange them and resize 

them every time you switch to a different task. But Paratext lets you save different 

screen layouts and change between them easily. These are called TEXT COMBINATIONS. 

13.9 We will start by creating a practice Text Combination, and then you can experiment 

and decide what kind of arrangement you would like to use for your own work. 

13.10 Open your own translation project, your BACK TRANSLATION project and two RESOURCES 

that you frequently use. Close any other windows. 

13.11 ²ŜΩƭƭ Ŏŀƭƭ ǘƘƛǎ /ƻƳōƛƴŀǘƛƻƴ Practice layout. And since it is just a practice Combination, 

ǿŜΩƭƭ make ƛǘ Іф όƴǳƳōŜǊ фύΦ ²ŜΩƭƭ ƪŜŜǇ ІмΣ Ін ŜǘŎΦ ŦƻǊ ǘƘŜ ǊŜŀƭ /ƻƳōƛƴŀǘƛƻƴǎ ǘƘŀǘ ȅƻǳ 

create for your work.  

Tutor demonstrates, learners watch.  

Creating a Text Combination  

1. Open all the windows that you want to include in the Text Combination. 

2. Arrange these windows in a way that you like (that will be comfortable to 

×ÏÒË ×ÉÔÈɊȢ 9ÏÕ ÃÁÎ ÕÓÅ ÔÈÅ ȬÓÔÁÃËȭ ÆÕÎÃÔÉÏÎÓ ÏÎ ÔÈÅ Window  menu, and 

you can move or resize windows too. 

3. In each window, you can make the text appear larger or smaller by 

holding the Ctrl  key and tapping the + and ɀ keys. Ctrl  + + makes the 

text bigger. Ctrl  + ɀ makes the text smaller. 

4. Go to the Window  menu and choose Save TeØÔ #ÏÍÂÉÎÁÔÉÏÎȣ 
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5. The Save Text Combination window opens. 

 

6. At the top left, pick a number for your new Combination (use smaller 

numbers for Combinations that you use more often). 

 



Module  13: More on screen layout 

last edited 30 June 2011 111 

7. In the box you can type a name for your Combination that explains what 

task it is for (e.g. First draft layout or English Bibles GNT NIV NET). 

 

8. Click on OK. 

Tutor demonstrates, learners perform each step of demonstration after the tutor.  

13.12 Now ǿŜΩƭƭ change the screen layout, then see what happens you choose your Text 

Combination again. Start by going to the Window menu and choosing Unstacked. 

13.13 Move some windows around and change their size. Make them overlap. 

13.14 Now open two more windows. Your screen should be very messy now! 

13.15 Now go to the Window menu and choose 9 Practice layout. What happens? 

 ..........................................................................................................................................................................  

13.16 Now spend some time thinking about a real Text Combination that you would like to 

use when you work. What project and resource windows would you like to have 

open? ό5ƻƴΩǘ ƻǇen too many windows or the screen will be too crowded.) 

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

 ..........................................................................................................................................................................  

13.17 hǇŜƴ ŀƴŘ ŀǊǊŀƴƎŜ ǘƘƻǎŜ ǿƛƴŘƻǿǎ ƛƴ ŀ ǿŀȅ ǘƘŀǘ ȅƻǳ ƭƛƪŜΦ aŀƪŜ ǎǳǊŜ ǘƘŜǊŜ ŀǊŜƴΩǘ ŀƴȅ 

other windows open. 

13.18 Save this layout as Text Combination #1. Give it a name that explains the task it is for. 

13.19 Now go to the Window menu and choose 9 Practice layout again. What happens? 

 ..........................................................................................................................................................................  



112 last edited 30 June 2011 

13.20 Go to the Window menu again and look for the Text Combination that you made #1. 

What is its name in the menu? 

 ..........................................................................................................................................................................  

13.21 Choose that #1 Combination. What happens? 

 ..........................................................................................................................................................................  

13.22 If you decide later that you want to change your #1 Combination, just organise the 

windows the way you want them and save the layout as Text Combination #1 again. 

This will replace the original Text Combination #1 with the new Combination. 

13ɀ3 Text Collections  

13.23 A TEXT COMBINATION of resources is very useful, but it does use up a lot of screen 

space. Paratext has another way to display resources which uses less space. It is 

called a TEXT COLLECTION. 

13.24 Here are five texts as a Text Combination: 
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13.25 Here are the same five texts as a Text Collection: 

 

13.26 A Text Collection window allows you to see just one verse from different versions, 

without taking up too much screen space. When you change to another verse, all the 

resources in the Text Collection will change to show the new verse. 

13.27 CƛǊǎǘ ƻŦ ŀƭƭΣ ǿŜΩƭƭ ƭƻƻƪ ŀǘ ŀ ǎŀƳǇƭŜ ¢ŜȄǘ /ƻƭƭŜŎǘƛƻƴ όƛǘΩǎ ŎŀƭƭŜŘ Sample collection!). Close 

all the windows that you have open. 

Tutor demonstrates, learners watch.  

Open a Text Collection  

1. Go to the File  menu and 

choose Open Project/  

Resource in Text 

Collection... 



114 last edited 30 June 2011 

2. A window opens up. In the top left-hand corner is a box. Click on the 

downward-pointing arrow to  the right of the box, and choose the Text 

Collection you want. 

 

3. Then click on OK. A window opens up containing the Collection. 

 




























































































































































































































































































































